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Kalimetrix Logiscope

Chapter 1

Introducing Logiscope Studio

Logiscope Studio is an environment tool to build and visualize the results produced by
the Kalimetrix Logiscope™ toolset including CodeReducer, QualityChecker,
RuleChecker or TestChecker verification modules for application written in Ada, C,
C++, or Java.

Logiscope Studio is a multi-view tool, it can show source files as well as metrics values,
rule violations or test coverage.

« the Workspace View displays the File View including Logiscope project files,
« the Result Pane displays various windows (source files, html reports, ...),
« the Output Window displays project messages, error messages, warnings or results.

These views are presented in detail in the following chapter.

Logiscope Studio is a context-sensitive graphical tool. It is consistent and intuitive in its
design with palettes, menus, standard “drag and drop” features, as well as undo/redo.

On line context-sensitive help is available by using the Help icon or the F1 key

* to obtain help on the toolbar buttons, click the Help icon ﬂ then click on the desired
button;

* to get help on the pop-up menu commands, position the cursor on the desired
command then press the <F1> key;

« to get help on menus or areas, use one of the above.

Introducing Logiscope Studio 1
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Chapter 2

Studio Interface

2.1

2.2

Starting up Studio

To start up Studio do one of the following:

On Windows:

« open the Start menu and select Programs - Kalimetrix - Kalimetrix Logiscope
<version>, or

 in Windows Explorer, double-click a .ttp or .ttw file.

On UNIX:
« launch vcs binary.

Overview of Studio Windows

The picture below represents Logiscope Studio main windows:

File Edit “iew Browse Project Toolz Window Help
D@ Ea[MEExX s s e e E
ITest.vsp L"Default L”_E-J Logiscope LI ¥ o= | = = |
B0 |@eea|®<allni)
=l B Hangman.h =1
EI- Testvsw il < Hangman.h -
EI--- Test vsp o
-3 Quality Model s Ja= lE T M= E]
Workspace P e B Logiscope.ref ;; -
View =3 Source Files ~~ Hea| @ Factor : MAINTAINABILITY Z | Result Pane
L. GenercDlg.cpp o
Hangman.cpp
Hanaman32. cpr #1ifndef | This factor applies to the class.
Hangman32Dlg. #define | The formula to compute this factoris
H_inlDlg-CDD cla=ss C BAINTAINABILITY = ARALYZABRILITY
; PictureButtan. cp i + CHAMGEABILITY + STABILITY +
b Stdéfs cpp protect TESTABILITY
B Header Files -
| | L Class MAINTAINABILITY : Characterist
B the affort recgiired to meke odsen B
=2./@. e 0. @ | |lWU i =1 i
X|[radit Data Loaded. ;l
Output Alioading Audit Data. ..
Window lPaadit Data Loaded. >
JJ H_'\ Messages & Build / IEN | L4
Status Bar
& MM [ — o
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Description of Studio different windows:

Workspace View

The Workspace View displays the File View (main tab) with the project files: the
quality model file, source and header files, rule files and dynamic files. A double click on
any item displays it in the result pane.

This window is used to display any information related to the project including:
+ the File View tab,

+ the Quality tab,

+ the Dictionary tab,

+ the Criteriatab,

+ the Factors tab,

 the Metrics Values tab,
+ the User Request tab,
+ the Violations tab,

« the File Violations tab,
+ the Components tab,

+ the Tests tab.

Result Pane

Displays various result windows: source files, html reports...

Output Window

Displays messages and information on the project. It contains the Messages, Build,
Browse and Script tabs used to show warnings, error messages and results.

+ the Messages tab is used to give information on the project loading.
+ the Build tab is used to display the analysis results.

+ the Browse tab is used to visualize metrics, rules or test information.
« the Script tab is used to view the Tcl execution results.

4 Kalimetrix Logiscope Studio Reference Manual
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Status Bar

A display area for:

* help on toolbars buttons,

+ location (Ln x, Col y) in the active window from result pane,

« the tool execution status: when running, the indicator is =, otherwise it is & .

Note: Status bar can be displayed or hidden by checking or clearing the Display status
bar choice in the Editor tab of Tools - Options command.
Menu bar

The Menu bar includes available pull-down menus. Click a name to open the menu and
access the associated commands.

|Eile Edit “iew Browze Project Tool: Window Help

Here is a short description of these menus:

File contains project and file commands

Note: Recent Files or Recent Workspaces last used can be opened by
selecting the filename or the workspace from the File menu.

Edit contains editing commands

View contains commands to customize Studio window

Browse allows to display to different views of the project

Project contains commands to update and customize the project
Tools contains commands to customize tools, toolbars and options
Window contains commands to arrange multiple windows

Help contains online help commands

All commands are fully described in Chapter 3.
Note: Menu bar can be displayed or hidden by checking or clearing itself in other tool-
bar pop-up menu.
Toolbars

Toolbars provide shortcuts for some of the most common commands. Icons are grayed
out when they are not active.

Each toolbar is displayed at a default location or at the last location.

Displaying or hiding a toolbar:

A toolbar can be displayed or hidden by checking or clearing in one of the following
way:

Studio Interface 5
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* its name in the pop-up menu of any toolbar

« the Hide option in its own pop-up menu (except for Menu bar)

* its name in the Toolbars tab of Tools - Customize command (except for Menu bar)
* itsname in View command (only for Standard toolbar)

Moving a toolbar:

Point to the toolbar title bar and drag it to the desired location.

Customizing a toolbar:

Customize a toolbar by removing unwanted buttons or adding new buttons, menus or
commands with the Tools - Customize command.

Restoring a default toolbar:

Use the Reset button in the Toolbars tab of the Tools - Customize command.

Note: A custom toolbar cannot be reset.

Project Bar

IHangman32.ttp leefauIt le’; Logiscope j [ o | = [ ‘

e—

The Project Bar contains three drop-down lists to set up the active project, its
configuration and the tool. It also includes four buttons corresponding to commands of
the active tool.

Note: The active project can be set with a right click on a project in the File View and
choose the Set as Active Project option.

A configuration shows the tool active options. It is defined via the Settings... - Project
menu command.

Currently, tools available in the Logiscope environment are Logiscope Viewer and
Logiscope TestChecker.

. Build B4 1o generate and build the project. If the project has already been built, this
will only rebuild what has changed.

+ Stop A 10 stop the building process

* Rebuild all | to generate and build the project. This will force a rebuild of the
entire project.

. Start Viewer B2 to launch Viewer (available if the QualityChecker and TestChecker
modules have been activated).
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Start TestChecker E to launch TestChecker (available if the TestChecker modules
have been activated).

Note: To launch these commands, a project must be loaded in the File View.

Logiscope Bar

v/ eea gea

“l )

Allows to show specific results for the current project. From left to right, symbols allow

to:

display the Metrics Dictionary

display the Criteria Level

display the Factor Level

generate the HTML Quality Report and open it
display the Rule Violations

display the Rule Violation List

generate the HTML Rule Violation Report and open it
display the Component Coverage

generate the HTML Test Report and open it

Note: Items are available depending on the module activated for the current project, i.e.

QualityChecker, RuleChecker, CodeReducer or TestChecker.

To Shortcut Logiscope bar:

Click right on Logiscope toolbar and choose To shortcut command from the pop-up
menu. The toolbar appears in the shortcut palette:

e H

Logiscope

B etrics Dictionary

=0 LCriteria Lewvel

v Factor Level
1§ Quality Feport (F3)

s+ Rule Violations

== Rule Yiolationz List
*F Fule Yiolations Fepart

v Component Coverage

Al Test Report

Studio Interface 7



Kalimetrix Logiscope

To reinstall the commands in the toolbar, click right in the shortcut palette (once the
shortcut bar structure is developed) and choose the As Toolbar command from the pop-
up menu. The toolbar will go back to its initial location.

Standard Bar

|DEE@ s BBRXooE&| 2N

The Standard bar provides shortcuts for most commonly used commands of File and
Edit menus.
From left to right respectively, symbols allow to:

* create a new project or workspace
+ open an existing file
 save the active file
 save all files

* cut the selection
 copy the selection

« paste the selection

* delete the selection

+ undo

* redo

* edit properties

* print the active file

* help on Studio

* help on specific topics

Note: Items are available depending on the context.
Browse Bar
v

Provides a navigation tool in the Browse tab of the output window. From left to right
respectively, symbols allow to:

» select next item
« select previous item

TCL Script Bar

1
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Allows navigation in Logiscope internal data. From left to right respectively symbols
allow to:

execute the Tcl Script
open the Tcl Script Wizard

Mini Web Bar

I

Allows navigation in HTML documents and internal data.

=0 4 a

From left to right respectively symbols allow to:

Note:

go back to previous page
go to next page

stop the page loading
refresh the current display
go to the home page

For all the tabs displayed in the Workspace View and all the bars previsously described,
a contextual pop-up menu can be activated to hide, show or customize tabs or bars.

Hide:

2=

[Clualiby

v Wiorkzpace
v [utput

Shortouts

v Menu Bar

‘v Standard

v Froject

v Browse
Tel Scnpt

v Mini'weh
Weh

v Lirk

IT Logizcope

Customize. ..

Studio Interface 9



Kalimetrix Logiscope

2.2.1 Managing Studio Windows

Several files can be opened at the same time.

The windows display mode can be modified. In the Window menu, three Studio
operating modes are possible for window management. By default, the windows opened
are displayed in cascade.

Modify the display mode by choosing either Cascade or Tile display:

+ select Cascade or Tile option in the Window menu.
The Cascade mode is as follows:

B [Metric] AVGS: Average size of statements =13

¥ [Factor] MAINTAINABILITY [ _ [O] x|
ﬁ Language C++ Scope  Function

M ame

I function_MAINTAINABILITY

Description

LI Function MAIMTAIMABILITY: Characterizstics used to azsess
the effart required to rmake given modifications. =

KT | Mz

The Tile Vertically mode is as follows:
'+ [Factor] MAINTAINAE . =] B3 | IF IMekic] AVES: Aver M[=]Ed

# Language C++ Scope ﬁ? Language C++ Scope
Mame kremanic I.-’-'-.R-’GS

Ifunu:tiu:un_h*l.-“-‘-.IN TAIMABILITY

o Marme |.-’-'-.verage size of staterr
Description
Function MAINTAIMABILITY: Chara o
the effort required to make given mo™— Description D efirition: |

Thiz metric [ erage <

of operands and opers
E spression It iz ~alrlated & Fallee

Ifunu:tiu:n_.-‘i‘-.N.-'i‘-.LYZﬁ.EILlTY + functia - E ion N1+ HZ171 -
ROrEsEon + C stat
J | ﬁ RN IR ﬁ
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The Tile Horizontally mode is as follows:

v [Factor] MAINTAINABILITY E=l

FY
Iﬁi'Languang: C++ Scope  Function 3

M ame

I [Metric] AVGS: Average size of statements _ O] =]

ﬁ? Language C++  Scope Function Uzed B
b nemonic I,&,UGS
4] | A

A window can also be duplicated:

Select the New Window command in the Window menu.
The screen now contains two windows, each containing the same file.

The windows can be closed individually with the Windows-Close command or all at
once, Close All or with the File - Close command.

Kalimetrix Logiscope

Studio Interface 11



Kalimetrix Logiscope

2.3 File View (Tab)

The File View displays a workspace, one or more projects grouped in this workspace and
all files referenced by each project depending on its type (QualityChecker, RuleChecker,
Codereducer or TestChecker).

For easier visualization, the File View shows entities assembled by category in folders.
In each category, entities are displayed in alphabetical order.

In the following example the Hangman project (Hangman.ttp) is included in the
Hangman workspace (Hangman.ttw) with a quality model file (Logiscope.ref). Source
and header files of the project are also displayed as mentioned above.

=l

-l Hangmar, wew =
=-E# Hangman_vsp
=123 Quality Madel

------ B Logiscope.ref
=-£3 Source Files

----- % GenencDlg.cpp
..... ] Hangman.cpp

..... % Hangman32.cpp
----- % Hanagman32Dlg.c
..... E] HintDlg.cpp

----- % PictureButton. cpp
..... =] Stddfxcpp
=3 Header Files

----- % GenericDlg.h

..... ] Hangman.h

..... % Hangman32. b -

==

1| 1 »
Fileiew |

The File View content can be expanded (respectively collapsed) into parts:

* to expand (collapse) an item, click its preceding + (-) symbol or

* use the arrow keys or

 double-click on a folder
 to expand the whole File View content, use the star (*) key of the numeric pad.

To access an item, select it directly with the mouse or use the arrow keys to navigate in
the view; or type the first letter of its name (the item will be found and automatically
selected).

The File View main purpose is managing files in a Logiscope project. It allows to:

« display the Logiscope project file list,

+ edit the workspace and project(s), i.e.:

n display or edit (only for a project) their properties: select a workspace or project
and click the Properties icon, or right-click and choose the Properties option from
the pop-up menu, or use the Properties - View menu command,
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n add files (see the Add To Project - Files - Project menu command),

n remove files by using Cut - Edit menu or Delete - Edit menu command,

n organize the file presentation by using folders: add a new folder by using the Add
To Project - New Folder - Project menu command; move a file from a folder
to another by using the drag and drop mechanism (note that the appearance of the
cursor changes depending on whether it points to an authorized or unauthorized
location),

manage the project settings (see the Settings... - Project menu command for more
details),

visualize Logiscope file references via the Properties dialog (for more details, see the
Properties - View menu command).
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2.4 Quality (Tab)

This function allows to read the quality model definition (metrics, criteria and factors
used with their limits) according to Ada, C, C++ or Java languages. It is only available

for QualityChecker projects.

o ]
o ADA -]
o4 C
|___| -& C++
=k a Factor
- Application

El a Clazz
& MAINTAINABILITY
i REUSABILITY
- I:l Function

=8 a Criteria

- fpplication

L—_I a Class
Gl ANALYZABILITY

& CHANGEABILITY
@ SPECIALIZABILITY
@ STABILITY

&8 TESTABILITY

. USABILITY -
1| | 3

Fileview | [ Qualiy

Double click an item (factor, criterion or metric), an html window displays its definition
in the result pane.
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2.5 Dictionary (Tab)

All available metrics definitions appear for each language (C, C++, Ada and Java).
Double click a metric to get its corresponding description in the result pane.
It is always available.

All these metrics can be used to determine calculated metrics or criteria in the Quality
Model.

- d |
[

C

Application

Clasz

unction

CH: Estimated length

[ Praaram Difficulty

DES_CF#: Design T

E: Mental E ffart[H alzt

ESS_CPe: Ezzential

I: Inteligent content |

IND_CALLS: Mumbe:

L: Program Level [Ha

M: Praogram lenagth [H

M1: Total number of «

M2 Total number of «

----- 'ﬂ Y. Program “olume [k -
- ; i
1| | 3 |
Fil=vfiew '13 Dictionarny |

T
9

[+

[+

n

esssssssaase
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2.6 Criteria (Tab)

The Criteria tab displays components sorted by evaluation degree for each criterion. It is
only available for QualityChecker projects.

e

=l Hangman. vzp |
=23 Application

- ANALYZABILITY

- & CHAMNGEABILITY

- STABILITY

w4 TESTABILITY

=23 Claszes

- ANALYZABILITY

- & CHAMNGEABILITY

- STABILITY

w4 TESTABILITY

- USABILITY

- & SPECIALIZABILITY

- Methods & Functions

- & TESTABILITY

-8 STABILITY -
1| | v
Fileiew | €8 Criteria |

It allows to:

« Expand any criterion to get the analysis results with its evaluation degree F:
EXCELLENT, GOOD, FAIR or POOR.

» Expand each evaluation degree to show components, classes or application belonging
to that degree.

» Double click a criterion to get the corresponding html definition window with links to
criterion composition and metrics definition.

» Double click a component or a class to display its code in the result pane and its
metrics value in the output window (Browse tab).

» Double click a metric to get its definition in the result pane.
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2.7 Factors (Tab)

The Factors tab offers the same possibilities as Criteria: see paragraph 2.6. It is only
available for QualityChecker projects.

izlz

SR Hargmar vap:
=4 Application

-G MAINTAINABILITY

=-£3 Classes

- MAINTAINABILITY

H-5 EXCELLENT

& GOOD

=5 F&IR

- REUSABILITY
I':'I'a kethods & Functionz

G- MAINTAINABILITY
- relativeCall_MAINTAIMNAE

< | B
File... I '13 Dhctio... I & Factors I_
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2.8 Metrics Values (Tab)

Displays the computed basic metrics values according to application, classes, methods &
functions, depending on the type of the project. It is always available.

A double click on an application, a class or a method/function opens an html table in the
result pane with the corresponding basic metric names and values.

o )

=l CPPAudit. vsp ﬂ

[:l Application J
L——_Ia Clazzes

..... ®% CHangman

----- ®® CPRictureButton
..... ®® CHangman32Dlg
----- ®% CaboutDlg

..... ®% CHangman32&pp
----- B8 ChenencDlg

..... ™= CHintDlg

----- B8 CStringdmay

..... B% CSting

..... RS Cwindpp

..... mE O

----- B8 CSidioFile

..... B8 CButton

----- B8 ChMenu

----- B% CRect

----- RS CPainthl hal
| | 3

Filet e @] uiality |B ketrics Walues r
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User Request (Tab)

The User Request tab displays for the current project the list of classes or methods/
functions for the chosen criterion or factor evaluation degree. It is only available for
QualityChecker projects.

A double click on any item will display the source file window and shows its metric
values in the output window.

----- & CPictureButton:: CPictureB
----- &% CPFictureButton:Autaload
----- § CHintDlg:CHintDIg [Cwine
----- & CHintDlg:DoD ataExcharn
----- & CHintDlg:5etQuate [CStrir
----- % CaboutDlg:CaboutDlg ()

----- & CaboutDlg:DoDatak wcha
----- & CHangman320lg::CHangn
----- & CHangman3200g:0nlnitDi
----- & CHangman320lg:0nSy:C
----- & CHangman32Dlg:0OnDest
----- & CHangman3200g:0nPaint
----- & CHangman320g:0nQuer,
----- & CHanaman3200g:0nButte

----- & CHanaman32Dlg: OnButtc -
4 | 3

Filetiew | 7% Uszer Bequest |

Note: It is possible to make multiple requests by adding them in the User Request tab or
by creating a new tab.
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2.10 Violations (Tab)

Displays the violated, clean (not violated) and ignored rules for the current project. A
double click on a rule opens its description in html format in the result pane.
It is only available for RuleChecker projects.

A double click on a violated line opens the corresponding source file and highlights the

violation.
x|
=l CPPRule. vsp =
L——_Ia Yiolated Rules
-3 an
=-3F blockdecl
& [#] D\Program Files\Telelog
|#] [D:4Program Files\ T elelogiciLe
- #-[#] D\Program FiIes'&TeIeIngJ
-3 brkcont
i cast
-3 catchef
-3 cmclass
! conzk
! constcpy
! constririt
! ctriblack -
o »i

Fileview | JE Winlations |
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It displays the files in the current project where the violations occurred. It is only
available for RuleChecker projects.

A double click on a rule opens its description in the result pane.

A double click on a violated line opens the corresponding source file and highlights the

violation.

~lx

El'a Yiolated Files
El resource.h
: Et Headercom

¥ hrnztruct
E|¥ hOpreproc
g Line BB

- [#] Hangman h
] PictureButton.k
E Hanaman3Z2Dlg.k
#] Hangman3z.h
*] GenericDlg.h

E Genenchlg.cpp
E Hanaman.cpp

] Hangman3Z.cpp
2 HintDlg. h

Fileiew | JF Filsviolations
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2.12 Components (Tab)

It displays components sorted by source files in the current project. It is only available

for TestChecker projects.

A double click on a file opens a Component window in the result pane, with DDP and

MCDC coverage rate for each component in this file.

A double click on a component opens a Test window in the result pane, with DDP
coverage, DDP improvement, MCDC coverage, MCDC improvement, comment and

status for each test.

HangmanT est_vsp
E| GenencDlg.cpp
: ----- & CGenerchlg:CGenencDlg:20

----- & CGenencDlg:DaoDataExchange: 27
e ChenencDlg:Settuote;: 44
Hangran. cpp

Hangman32.cpp

Hangman32Dlg.cpp

HintD'g. cpp

FictureButton. cpp

File"»-"iewl [T Tests] [Fd Companents |
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2.13 Tests (Tab)

It displays tests sorted by dynamic files in the current project. It is only available for
TestChecker projects.

A double click on a dynamic file opens a Test window in the result pane, with DDP
coverage, DDP improvement, MCDC coverage, MCDC improvement, comment and
status for each test in this file.

A double click on a test opens a Component window in the result pane, with DDP and
MCDC coverage rate for each component.

]

iHangmanTest vzp!
=-4T] Tchk.dyn
: ----- “ff TEST_1
: P “fi| TEST 2
E@ TehkZ. dwn

e “fil TEST 3

Filgview | [Fd Tests l (4 I:Dmpu:unentsl
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2.14 Browse (Tab)

This tab is an Excel table displaying textual results, that may be saved in an Excel file
using the Save As pop-up menu. It is used for all types of projects (QualityChecker,
RuleChecker, CodeReducer and TestChecker).

A double click on a metric or a selection and activating Locate pop-up menu opens its
description in html format in the result pane.

:":Il ketric : CHangran32Dlg:: OnDestroy (] | W alue | b | kin | Status | -
'13 AVES: Average size of statements B0 3.00 1.00 0 b
'13 COMF: Comments frequency 0.z0 +00 .20 0
RFAN_IN: Fan In 0.00 0.00 i
'13 FAM_OUT: Fan Out n.oo 4.00 0.00 ]
__19 LEYL: Number of levels 1.00 4.00 1.00 1] _lll
[ 4]+ [/ Messages A Buid #, Browss f |u r
Done | & [NUM | 4

A click on a column header in the Browse tab sorts the list in ascending order.

2.15 Script (Tab)

It is used to print the a messages in the output window when the Script is executing a Tcl

command.
¥|[Error durihng tol ewvaluation: "
:]can't read "projeckxx": no such warialkle

while axecubing
"foreach item Sprojectxx
# Put an acktion on the item

| [}

| HI 4 I }I B h Messages)\l Su:ript,.{ ||l| _"lJ

Ln 1, Col 24 o
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2.16 Kiviat Graph (only on Windows)

The Kiviat Graph is a representation of all metrics values. The outer circle symbolizes

upper bounds and the inner circle symbolizes lower bounds. It is available for a
component at criterion and factor level.

It is only available for QualityChecker projects.

/) Kiviat Diagram

1vIa 1Iagram 1or aou o -

FAM_THclass
FaM OUTclass cu_cdusers

LUTONON

TESTAR ol wrno &
4| s
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2.17 Script Wizard

The Script Wizard can be opened by clicking the script wizard button &N of the Tcl
script toolbar. It allows to navigate in the UML representation of a Logiscope project and
to create Tcl scripts to extract information from the project.

<} Script Wizard

Create scrpt code  Copy soript code  Ewal scriph code

Class ApiBase

— Aszszociations

Defined in| Multiplicity| Mame |Distant class

ApiBaze 0.1 metrich aze | MetricBaze
ApiBase 0+ project Project

+ Operations

Copyright @ Telelogic AR - 2000

|

The UML metamodel describes the project structure and Logiscope entities (see the
description in Appendix A). The Mini Web toolbar allows to navigate in the UML
model.

To consult Logiscope data, simply navigate in the UML metamodel and click on Eval
script code (always displayed at the top of the page): the data are displayed in the
Browse tab of the output window or in the Script tab for textual information.

The Browse toolbar JJ‘F =¢ allows to navigate up and down in the Browse tab and to
open the view associated to each item.

The navigation and the resulting model query can be stored in a Tcl script by using the
Create script code option (always displayed at the top of the page): a Tcl view displays

the script. Execute it by using the Execute script button ! of the Tcl script toolbar;
save it by using the Save - File menu or Save As - File menu command. To simply
copy it, use the Copy script code option (always displayed at the top of the page): then
paste it in another script or document.
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Use Tcl scripts to create another parameterizable view and display it in the Framework
View. To create such a script, use the Create script code option as described previously,
then use one of the following functions in it:

BrowserReportInit tabName [iconFile] [-keep] [-cb tclFile]: this command allows to
activate a tree tab inside the framework. If needed the tab is created. If iconFile is
present, then the icon will be used as the tab image. If keep is present then the contents of
the tab (if any) are kept, otherwise the tab is reset. If the -cb tclFile is present, then the
associated Tcl script will be evaluated when a double click on a tree object occurs and
the OnDoubleClick proc of this Tcl script will be called with double clicked object as
parameter.

BrowserReport [-expanded] identObj [parentObj]: this command is used to add a new
object in the tree. If -expanded is present and if the object has children, then the node will
be expanded, otherwise it will be collapsed. If parentObj is present the node is created as
a child of the node corresponding to parentObj.

Reportinit [-check] [-cb tclfile] [column-label column-width column-alignment]+: This
command is used to create a new report tab in the output window. If the -check is used, a
check box is displayed before each result line. These check boxes allow a more powerful
navigation: only the checked lines will be selected when navigating with the F4 key,
others are ignored. If the -cb tclFile is present, then the associated Tcl script will be
evaluated when a double click on a line object occurs and the OnDoubleClick proc of
this Tcl script will be called with double clicked object as parameter. For each column-
label column-width column-alignment a new column is created with the corresponding
label, width and alignment. An alignment of O means left align and an alignment of 1
means right. For sorting, columns right aligned are considered as number and columns
left aligned are considered as text.

Report sourceObject [label]*: this command is used for adding new lines in a report
tab. The sourceObject will be used to fill the first column (icon + text) automatically. The
labels, are used to fill the remaining columns.

Output msg: this command allows Tcl script to print a message in the Tcl output tab.

Note: See Appendix A for more details.
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2.18 Textual View

Displays the content of a textual file (source code, quality model, rule set, dynamic
execution file).

B Hangman32DIg.h M=l

A Hangmand2Dlg. h : header file
A

#ifndef CHANGMANIZ2DLG_H
#define CHANGMANIZDLG_H

$include "Hangmen h"
#include "PictureButton h”

A
A CHangmani2Dlg dialog
class CHangmani?zDlg : public CDialog

S0 Construction
public:
woid OnCQE{);
CHangmaniZzD1lgi{Clnd* pFarent = HULL): A

< Dialog Data
SALTAFE DATA(CHangman3ZzDlg)
enum { IDD = IDD HAWNGHMANIZ DIATOG 1}
CPictureButton m_cntrlPic:
CButton m_btnZe¥;
CButton m_btnZb¥; P

Lo 1o

KAN ' ' 3y

The programming language keywords appear in a different color than the rest of the
words in order to make reading easier.

Example: green for comments, blue for keywords, purple for strings and black as the
default color.
The line and column for the cursor position are indicated to the right of the Status bar

A Textual View allows to:

« consult a textual file content,

» edit atextual file content; several functionalities facilitate its edition:

n

n

n

type new text or change an existing one,
find: to quickly locate character strings (see the Find - Edit menu command),

replace: to find and replace character strings (see the Replace - Edit menu
command),

marks set: mark lines by using the <Ctrl+F2> key or the Mark All option of the
Find dialog. Once the string occurrences have been marked, jump from one string
to another by using the F2 key. To go down, press the F2 key. To go up, use the
<shift+F2> key. Use the <Ctrl+F2> key again to delete a marker and use the
<Ctrl+Shift+F2> key to suppress all marks.

undo/redo as for the others view,

cut/copy/paste character strings,
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 propagate modifications to the Logiscope project by building it again.

2.19 HTML View

Used to display quality, rule violation and test coverage reports as well as metrics,
criterion or factor definitions in the quality model.

Rational Logiscope Quality Report

Date: 11 Mar 2009

This document contains infarmation concerning the quality analysis of the project MastermindReviewer made
Logiscope QualityChecker which is part of IBM®& Rational® Logiscope.

The following levels of information are availakle:
« Application

« Functions
& 3Source files list

Application Level

The following levels are availakle for Application analysis:

s @AFactor level
« & Criteria level
+ ) Metric level
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Chapter 3

Studio Commands
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About Kalimetrix Logiscope - Help menu

Display Studio and Kalimetrix Logiscope version information
View
Can be launched from any view.

Context

Always available.

Seek command
+ Button palette E

Result

A message box containing Studio and Kalimetrix Logiscope version information pops
up.

Note: Studio and Logiscope are two separate products, each having its own version
number.
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Add To Project - Components - Project
menu

Not available
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Add To Project - Files - Project menu

Add files to the current project

View

Can be launched from the File View.

Context

Either a project is active or a project or a project folder is selected.

Seek command

» Pop-up menu: Insert Files

Dialog

An Open dialog box pops-up (for more details, see Open - File menu command).
Select or enter the name of the file(s) to be added.

Result

The new file is added in the project. The File View is updated, select the new file and
drag and drop it into the required folder.

Save the workspace to take all changes into account.

Possible errors

The following blocking errors may occur because of incorrect entries:
» The added file does not exist,
« The user does not have read access to the file to be added,

« The added file already exists in this project (same name and path),
In all these cases, the dialog box remains opened even after clicking OK.
The user has to enter another filename or cancel the command.
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Add To Project - New Folder - Project
menu

Add a folder to the current project

View

Can be launched from the File View.

Context

Either a project is active, or a project or a project folder is selected.

Seek command

» Pop-up menu: New Folder

Dialog

A New Folder dialog box is opened: enter the name of the folder to be added.

Save the workspace to take all changes into account.

Result

A new folder is added to the project and displayed in the File View. If a project folder is
selected, the new one is created as a sub-folder of the selected one.
Otherwise, the new folder is created at the first level in the project.
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As Toolbar - Pop-up menu

Convert the Shortcuts View into a Toolbar

View

Can be launched from the Shortcuts View.

Context

Always available.

Result

A pop-up menu appears in the Shortcuts when right-clicking. The selection of the As
Toolbar option allows to display the shortcut list as a toolbar.

To display the toolbar as an embedded listbar in the Shortcuts View again, click right
and choose the To Shortcut - Pop-up menu option.

36 Kalimetrix Logiscope Studio Reference Manual



Kalimetrix Logiscope

Back - Button palette

Navigate back in the Script Wizard or in an HTML view

View
Can be launched from the Script Wizard or an HTML view.

Context

At least one page has been previously displayed.

Seek command

 Button palette &«

Result

This command allows navigating back in the Script Wizard or in an HTML view: it
displays the previous page.
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Basic Metrics Values - Browse menu

Display the computed basic metrics values for the current project

View

Can be launched from any view.

Context
Always available when an QualityChecker project is loaded but significant only for a
built project.

Result

This command displays the Metrics Values tab in the Workspace View. It gives the
computed basic metrics values for the current project (depending on the project type). A
double click on an application, a class or a method/function opens an html table in the
result pane with the corresponding basic metrics names and values.

Note: For unbuilt projects, metrics values are not significant.
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Browse - Pop-up menu

Hide or display the Browse bar

View

Can be launched from a toolbar.

Context

Always available.

Result

With a right click on a toolbar, a pop-up menu appears. The toolbar can be hidden or
displayed depending on its current state.

See Toolbars tab in Customize - Tools menu command.
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Build - Project menu

Generate results (output and files) for the active project

View

Can be launched from the File View.

Context

Always available.

Seek command
* Shortcut; <F7>

Result

This command generates results (output and files) for the active project. If the project has
already been built, this will only rebuild what has changed. The options used to generate
are those of the active configuration (see the Settings... - Project menu command for
more details). The output files are generated in the project directory.

Note: consult Kalimetrix Logiscope RuleChecker & QualityChecker Getting Started and
Kalimetrix Logiscope TestChecker Getting Started for more information on the
generation.
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Cascade - Window menu

Arrange windows as overlapping tiles

View

Can be launched from any view.

Context

Always available.

Result

When the windows are in cascade, they appear in a stack. The window on the bottom of
the stack occupies the upper left corner of the screen in the result pane, and the remaining
windows are offset vertically and horizontally so that the left border and title bar of each
window is visible.
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Clear - Pop-up menu

Clear the active tab in the output window

View
Can be launched from the Message or Build tab in the Output window.
Context
Available if the active tab is not already cleared.
Result

The active tab content is cleared.
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Close - File menu

Close the current window

View

Can be launched from all views except those in the Workspace View.

Context
Always available.

Dialog
If a file has been modified and not saved before closing the view, a dialog box is
displayed and lets save it. Choose ‘Yes’ to save and close, ‘No’ to close, ‘Cancel’ to
cancel the command.

Result

The current view closes.
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Close All - Window menu

Close all opened windows

View

Can be launched from all views except those in the Workspace View.

Context
Always available.

Dialog
If a file has been modified and not saved before closing the view, a dialog box is
displayed and lets save it. Choose “Yes’ to save and close, ‘No’ to close, ‘Cancel’ to stop
the command.

Result

The views close.
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Close Tab - Pop-up menu

Close a parameterizable view

View

Can be launched from any parameterizable view.

Context

Always available.

Result

The current parameterizable view is closed and disappears from the Workspace View.

Studio Commands 45



Kalimetrix Logiscope

Close - Window menu

Close the current window

View

Can be launched from all views except those in the Workspace View.

Context

Always available.

Dialog

If a file has been modified and not saved before closing the view, a dialog box is
displayed and lets save it. Choose ‘Yes’ to save and close, ‘No’ to close, ‘Cancel’ to
cancel the command.

Result

The current window closes.
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Close Workspace - File menu

Close the current workspace

View

Can be launched from all views.

Context

A workspace must be opened.

Dialog

If modifications have been made in the workspace or in files, a dialog box is opened and
prompts to save the changes or not:

 Click “Yes’ to save the changes and continue the close command,
 Click ‘No’ to continue without saving,
 Click ‘Cancel’ to stop the close command.

Result

The workspace is closed, with or without save action.

Possible errors

The possible errors are those linked to saving (see the Save - File menu command).
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Components - Pop-up menu

Hide or display the Components view
View
Can be launched from a tab in the Workspace View.

Context

Always available when a Test project is loaded.

Result

With a right click on the tab, a pop-up menu appears. The view can be hidden or
displayed depending on its current state.
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Configurations - Project menu

Add or remove code generation configurations and designates the
active project and configuration

View

Can be launched from any view.

Context

A project is opened.

Dialog

A Configuration dialog box is opened. It contains the following buttons:
+ Close to close the dialog box.

« Add to create a new configuration based on an existing one: an Add Configuration
dialog opens. Enter the new configuration name in the New name field, choose an
existing configuration to initialize the new one in the Copy from list, select the
project to attach the new configuration in the Project list. Click OK to confirm, or
Cancel to cancel the command.

» Remove to delete a configuration: select a configuration then click Remove.
» Set Active to designate the active project and configuration.

Result

The modifications are applied to the projects. The project bar is updated (displays the
active project and configuration).
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Copy - Edit menu

Copy entities into the paste buffer

Context

Requires selection of the entities to be copied.

Seek command
« Shortcut: <Ctrl+C>
* Pop-up menu

B
+ Button palette

Result

Internal changes
The selected entity (text) is copied into the paste buffer.

Changes to the views

The result of the operation is transparent to the user. The effect will only be visible after
activation of the Paste command.
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Copy All - Pop-up menu

Copy all the entities into the paste buffer
Result

Internal changes

The entities (text) are copied into the paste buffer.

Changes to the views

The result of the operation is transparent to the user. The effect will only be visible after
activation of the Paste command.
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Customize - Tools menu

Customize toolbars or the Tools menu

View

Can be launched from all views.

Context

Always available.

Seek command

* Pop-up menu on a toolbar

Dialog

The customized dialog box contains three tabs:

+ aCommand tab to add a button to a toolbar: in the Categories box, click the category
that contains the command or the item to be added. Drag the button from the Buttons
area to the toolbar.

» aToolbars tab to:

n

Note:

Display or hide toolbars: click the toolbar names to be displayed. Clear the check
boxes for any toolbar to be hidden. Each toolbar appears in a default location or in
the last location it was moved to.

the Menu bar cannot be hidden this way.

Show the ToolTips: check Show ToolTips. ToolTips are on-screen descriptions of
toolbar buttons that appear when the mouse points over a button.

Modify the toolbar buttons appearance: check Cool Look.

Enlarge the toolbar buttons: check Large Buttons.

Create a new toolbar: click New and type a new toolbar name. Move the
Customize dialog box aside to see the new toolbar, then use the Command tab to
add buttons to the new toolbar.

Restore a default toolbar: in the Toolbar box, click the toolbar name to restore to its
default state, then click Reset. A custom toolbar cannot be reset.

Delete a custom toolbar: in the Toolbar box, select the name of the custom toolbar
to delete and click Delete. A default toolbar cannot be deleted.

Rename a custom toolbar: in the Toolbar box, click the toolbar to rename. In the
Toolbar name area, type the new name. Press Enter. A default toolbar cannot be
renamed.
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» aWindows Layouts tab to define named configuration (windows position).
n To define a configuration, click the New icon and give a new name.
n To restore a configuration, select its name in the list and click the Restore button.

X .

n To suppress a configuration, select its name and click the Suppress icon

+ aTools tab to add commands in the Tools menu. These commands can be associated
with any program that will run on the operating system. Also specify arguments for
any command to be added to the Tools menu:

n To add a command to the Tools menu: click the New icon or press Insert key. A
blank line (indicated by an empty rectangle) appears in the Menu Contents box:
type the name of the tool as it will appear on the Tools menu, and press Enter.

For example, to add a command to Windows Notepad accessory, type Notepad.

The remaining steps will be to specify what action will occur when the new

Notepad command is selected.

In the Command box browse or type the program pathname, for example

C:\WINDOWS\NOTEPAD.EXE.

In the Arguments text box, browse or type any arguments to be passed to the

program. Use the drop-down arrow next to the Arguments text box to display a

menu of arguments. Select an argument from the list to insert argument syntax into

the Arguments text box.

In the Initial Directory box, browse or type the file directory where the command

is located.

Click OK to validate. The command appears in the Tools menu: select it from the

menu to run it.

n To edit acommand of the Tools menu: in the Menu Contents box, select the
command to edit. Perform one or more of the following actions:

p To move the command up one position in the menu, choose the Move Up
button.

p To move the command down one position in the menu, choose the Move Down
button.

p To change the menu text, command line (tool path and file name), command-
line arguments, or the initial directory, type the new information in the
appropriate text box.

p To specify a letter in the menu title as an access key, precede that letter in the
Menu Contents box with an ampersand (&). By default, the first letter in the
title is the keyboard access key.

p To specify sub-menu items, use a\.

p To specify that a console application output is displayed in the output window
rather than in the console window, click Use Output Window.

p To be prompted for command-line arguments each time the tool is run, select

Prompt for Arguments.

n Toremove acommand from the Tools menu: in the Menu Contents box, select the

command to be deleted and press the Delete button.
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e an Add-ins tab:

n To create an add-in module by clicking the Create button and filling the different
fields in the Attributes, Binaries, Scripts or Other files tab. Once the add-in is
created a new directory appears in the <log_install_dir>\addins directory.

n To activate or desactivate an add-in module by clicking on the check box and
closing the dialog window (the activation/desactivation occurs once the window is
closed).

n To modify an add-in module by clicking the Modify button and filling the different
fields displayed in the window.

Result

The toolbars and/or the Tools menu are customized according to choices made.
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Cut - Edit menu

Cut entities and transfer them to the paste buffer

View

Can be launched from any Textual View.

Context

The entities to be cut must be selected.

Seek command

« Shortcut: <Ctrl+X>
* Pop-up menu

3

 Button palette

Result

This command transfers the selected entity (text) to the paste buffer and removes it from
the view (for more details, see the Result paragraph of the Delete - Edit menu
command).
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Delete - Edit menu

Delete entities

View

Can be launched from any Textual View.

Context

The entities to be deleted must be selected.

Seek command

» Shortcut: <Del>

+ Button palette x

Result

This command deletes the selected entity (text).
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Display Incoming Links - Link menu

Display the incoming links for an object

View

Can be launched from a file or a folder.

Context

Always available when the object has some links.

Seek command

« Pop-up menu on the object

Result

The incoming links are displayed in the Link tab of the Output window.
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Display Outgoing Links - Link menu

Display the outcoming links for an object

View

Can be launched from a file or a folder.

Context

Always available when the object has some links.

Seek command

* Pop-up menu on the object

Result

The outcoming links are displayed in the Link tab of the Output window.
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Edit Links - Link menu

Display the links or hyperlinks for an object

View

Can be launched from a file or a folder.

Context

Always available (even if the object hasn’t any links).

Seek command

« Pop-up menu on the object
 Button palette =

Result

The outgoing and incoming links and hyperlinks are displayed in a window. They can be
selected and then set as default or deleted, but they cannot be changed this way.
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Execute Script - Tools menu

Execute a Tcl script

View

Can be launched from a Tcl view.

Context

Always available.

Seek command
» Shortcut: <Ctrl+F5>

+ Button palette !

Result

This command executes the current Tcl script. The result can be displayed in the output
window or in a parameterizable view, depending on the script.

Possible errors

If the Tcl script is syntactically incorrect, an error message is displayed in the script tab
of the output window.
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Exit - File menu

End a session

View

Can be launched from any view.

Context

Always available

Dialog

If modifications have been made in the workspace or in files, a dialog box is opened and
prompts to save the changes or not:

 Click “Yes’ to save the project and continue the exit command,
 Click ‘No’ to continue without saving,
 Click ‘Cancel’ to stop the exit command.

Result

All windows are closed and the Studio session is finished, with or without save action.

Possible errors

The possible errors are those linked to saving (see the Save - File menu command).
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Export - File menu

Export CodeReducer, QualityChecker or RuleChecker result data in
CSV format files

View

Can be launched from any view.

Context

Only available if the project loaded has been built.

Dialog

Activate the command File - Export - CSV format -

» CodeReducer Data: to export the CodeReducer results: location of all similarities
found.

* QualityChecker Data: to export the RuleChecker results: values of metrics, rating
at criteria and factor level for each component analysed.

* RuleChecker Data: to export the RuleChceker results: location of all violations
found.

Result

CSV files containing the results data are generated in the report.dir folder in the
Logiscope repository of the project loaded.

Possible errors

Lack of space on the disk.
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FAQs - Help menu

Display Kalimetrix Logiscope FAQs (Frequently Asked Questions)
View
Can be launched from any view.

Context

Always available.

Result

An html file containing FAQs on Logiscope is displayed with links to online Kalimetrix
support.
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File View - Pop-up menu

Hide or display the File View
View
Can be launched from a tab in the Workspace View.

Context

Always available when a project is loaded.

Result

With a right click on the tab, a pop-up menu appears. The view can be hidden or
displayed depending on its current state.
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Edit menu

Find a character string

View

Can be launched from a Textual View.

Context

Always available.

Seek command

Shortcut; <Ctrl+F>

Dialog

A dialog box is opened. It contains the following fields:

Find what enter the character string to be searched; a scrolling list containing the
previous searched strings also lets choose one of them without re-entering it. If a
string was selected in the text before starting the command, it appears in this field.

Match whole word only: select it to search isolated occurrences of the string only.
Match case: select it to discriminate between uppercase and lowercase characters.
Direction: select Up or Down to indicate the direction of the search.

The dialog box contains the following buttons:

Find Next to find the next occurrence of the string and close the dialog box. Once the
dialog is closed, use the F3 key to continue the search downwards or press
<Shift+F3> for searching upwards.

Mark All to mark all string occurrences in the text. Once the string occurrences have
been marked, jump from one string to another with the F2 key. Go down with the F2
key. Go up with the <Shift+F2> key. The <Ctrl+F2> key allows adding or deleting a
marker and use the <Ctrl+Shift+F2> key to suppress all marks.

Cancel to cancel the command.

Result

When an occurrence of the searched string is found, it is highlighted.

Possible errors

The searched string is not found. An error message box is opened: click ‘OK” to come
back to the Find dialog box.
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Full Screen - View menu

Allow to put the current view into full screen

Context

Always available.

Result

The current view is put into full screen, click on the Close FullScreen icon

back.

to go
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Give access to online help

View

Can be launched from any view.

Context

Always available.
Seek command
 Button palette ﬂ

Result

Kalimetrix Logiscope

This command allows consulting the help on line through a list of help chapters, an index

or a research mechanism.
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Hide - Pop-up menu

Hide a toolbar

View

Can be launched from a toolbar.

Context

Always available.

Result

With a right click on a toolbar, a pop-up menu appears. The selection of the Hide option
makes it disappear.

To display the hidden toolbar check its name either in the Toolbars tab of the
Customize - Tools menu command or in the pop-up menu of another toolbar.
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Home - Button palette

Navigate to a home page (HTML)

View
Can be launched from the Script Wizard or an HTML view.

Context

Always available.
Seek command
+ Button palette @

Result

This command displays the home page. In the Script Wizard, the home page contains
the two entry points of the UML metamodel.
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Insert Project into Workspace - Project
menu

Add projects in the current workspace
View
Can be launched from the File View.

Context

Always available when a workspace is loaded.

Seek command

* Pop-up menu

Dialog

An Open dialog is opened (for more details, see the Open - File menu command).
Select or enter the name of the project(s) to add.

Result

Internal changes

The workspace is updated: the new project is added to the current set of projects.

The entities of the new project are loaded.

Changes to the views

The new project appears in the File View.

Possible errors

An error may occur if the added project does not exist.
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Kiviat graph - View menu

Display the Kiviat graph for a component
View
Can be launched from Criteria or Factors view in an QualityChecker project.

Context

A component must be selected.

Seek command
* Shortcut; <Ctrl+K>
* Pop-up menu

Result
The Kiviat graph is displayed in the result pane.
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Large Icons - Pop-up menu

Increase the size of icons in the Shortcut view
View
Can be launched from the Shortcut view.

Context

Always available.

Result

Click right in the shortcut list and a pop-up menu appears. The selection of the Large
Icons option allows to display large icons.
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Link - Pop-up menu

Hide or display the Link bar

View

Can be launched from a toolbar.

Context

Always available.

Result

With a right click c& a toolbar, a pop-up menu appears. The toolbar can be hidden or
displayed depending on its current state.

See Toolbars tab in Customize - Tools menu command.
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Link Options - Link menu

Display the links and hyperlink options
View
Can be launched from any view.

Context

Always available.

Seek command
+ Button palette

Result

The links and hyperlink options window is opened (see Links and Hyperlink tabs in
Options - Tools menu).
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Locate - Pop-up menu

Locate the active information by opening the corresponding source or
html file in the result pane
View

Can be launched from the Browse tab in the Output window.

Context

Always available.

Seek command
 Click right on an item.
* Pop-up menu

Result

The source file or html file corresponding to the active information is opened in the
result pane.
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Logiscope - Pop-up menu

Hide or display the Logiscope bar

View

Can be launched from a toolbar.

Context

Always available.

Result

With a right click on a toolbar, a pop-up menu appears. The toolbar can be hidden or
displayed dependirég |n its current state.

See Toolbars tab in Customize - Tools menu command.
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Make Link from Start - Link menu

Allow to define an incoming link from the start object

View

Can be launched from a file or a folder.

Context

Always available when the Start Many Links mode is active.

Seek command

« Pop-up menu on the object
 Button palette
+ Shortcut: <Ctrl+L>

Result

The first selected object is defined as the start point (it has incoming/outcoming link
from/on itself), all other objects have an incoming link from the start.
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Menu Bar - Pop-up menu

Hide or display the Menu bar
View
Can be launched from a toolbar.

Context

Always available.

Result

With a right click on a toolbar, a pop-up menu appears. The toolbar can be hidden or
displayed depending on its current state.
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Metrics Dictionary - Browse menu

Display the basic metrics for all languages
View
Can be launched from any view.

Context

Always available when an QualityChecker project is loaded.
Seek command
 Button palette M

Result

This command displays the Dictionary tab in the Workspace View. It gives for each
language (C++, C, Java and Ada), the basic metrics used for the different scopes:
Application, Class (only available for C++ and Java) and Function.

A double click on a metric opens its description in html format in the result pane.
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Mini Web - Pop-up menu

Hide or display the Mini Web bar

View

Can be launched from a toolbar.

Context

Always available.

Result

With a right click on a toolbar, a pop-up menu appears. The toolbar can be hidden or
displayed depending on its current state.

See Toolbars tab in Customize - Tools menu command.
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Move - Pop-up menu

Move atoolbar
View
Can be launched from an undocked toolbar.

Context

Always available from the title bar.

Result

With a right click on the title bar of a toolbar, a pop-up menu appears. The selection of
the Move option allows to change the position of the toolbar.
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New - File menu

Create a new project or workspace

View

Can be launched from all views.

Context

Always available.

Seek command
* Shortcut: <Ctrl+N>

+ Button palette N

Result

Internal changes

The workspace and/or the project are created and loaded (the corresponding files are
created at the specified location). The default folders of the new project are initialized.

Changes to the views
» The File View is updated.

 Ifanew workspace is created, all the modified files related to the previous workspace
are prompted to save.

Possible errors
» No write access to a specified location.
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New Application Criteria - Pop-up menu

Add a new application criterion

View

Can be launched from the Quality tab of any QualityChecker project.

Context

Always available.

Result

A new application criterion is created for the selected language and with the default
name ApplicationCriteria_i. Then, start the Quality Model Editor to customize this new
item (see the corresponding chapter).
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New Application Factor - Pop-up menu

Add a new application factor

View

Can be launched from the Quality tab of any QualityChecker project.

Context

Always available.

Result

A new application factor is created for the selected language and with the default name
ApplicationFactor_i. Next start the quality model editor to customize this new item (see
Chapter 4, Quality Model Editor).
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New Application Metric - Pop-up menu

Add a new application metric
View

Can be launched from the Quality tab of any QualityChecker project.
Context

Always available.

Result

A new application metric is created for the selected language and with the default name
ApplicationMetric_i. Next start the quality model editor to customize this new item (see
Chapter 4, Quality Model Editor).
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New Class Criteria - Pop-up menu

Add a new class criterion

View

Can be launched from the Quality tab of any QualityChecker project.

Context

Always available.

Result

A new class criterion is created for the selected language and with the default name
ClassCriteria_i. Next start the quality model editor to customize this new item (see
Chapter 4, Quality Model Editor).
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New Class Factor - Pop-up menu

Add a new class factor

View

Can be launched from the Quality tab of any QualityChecker project.

Context

Always available.

Result

A new class factor is created for the selected language and with the default name
ClassFactor_i. Next start the quality model editor to customize this new item (see
Chapter 4, Quality Model Editor).
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New Class Metric - Pop-up menu

Add a new class metric

View

Can be launched from the Quality tab of any QualityChecker project.

Context

Always available.

Result

A new class metric is created for the selected language and with the default name
ClassMetric_i. Next start the quality model editor to customize this new item (see
Chapter 4, Quality Model Editor).
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New Function Criteria - Pop-up menu

Add a new function criterion

View

Can be launched from the Quality tab of any QualityChecker project.

Context

Always available.

Result

A new function criterion is created for the selected language and with the default name
FunctionCriteria_i. Next start the quality model editor to customize this new item (see
Chapter 4, Quality Model Editor).
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New Function Factor - Pop-up menu

Add a new function factor

View

Can be launched from the Quality tab of any QualityChecker project.

Context

Always available.

Result

A new function factor is created for the selected language and with the default name
FunctionFactor_i. Next start the quality model editor to customize this new item (see
Chapter 4, Quality Model Editor).

90 Kalimetrix Logiscope Studio Reference Manual



Kalimetrix Logiscope

New Function Metric - Pop-up menu

Add a new function metric

View

Can be launched from the Quality tab of any QualityChecker project.

Context

Always available.

Result

A new function metric is created for the selected language and with the default name
FunctionMetric_i. Next start the quality model editor to customize this new item (see
Chapter 4, Quality Model Editor).
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New Window - Window menu

Duplicate a view

View

Can be launched from any view displayed in the result pane.

Context

Not available for the File View (if no other window is opened, the command will not be
active).

Result

The current view is duplicated and its title changes (a number is added to differentiate
each occurrence of the view). A new window is opened.
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Next - Button palette

Navigate forward in the Script Wizard or an HTML view

View
Can be launched from the Script Wizard or an HTML view.

Context

It is possible to go forward.
Seek command

 Button palette =

Result

This command allows navigating forward in the Script Wizard or an HTML view: It
displays the following page.
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Next ltem - Button palette

Navigate down in the Browse tab of the Output Window

View

Effective in the Browse tab of the Output window.

Context

Items must be displayed in the Browse tab of the Output window.

Seek command
* Shortcut; <F4>

- Button palette %

Result

This command allows to navigate down in the Browse tab: it goes to the item placed
after the highlighted item of the displayed list and opens the view associated with this
new selection (for example, the metric issued from Criteria or Factors tab).

If no item has been previously selected, the command goes to the first item of the list;
when the last item is reached, it is wrapped up around the list.

A click on a column header in the Browse tab sorts the list in ascending order.
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Open - File menu

Open an existing file

View

Can be launched from any view.

Context

Always available.

Usage

This command is generally used to open an existing project (.ttp), html, source or Tcl
file. To open a workspace, it is better to use the Open Workspace - File menu
command.

A project can only be edited inside a workspace: if the opened project has no associated
workspace, a new one is automatically created inside Studio.

If changes have been made in the previous workspace and not saved, a dialog prompts to
save it before loading the new project: Yes to save and continue the project loading, No
to continue the command without saving the previous workspace, and Cancel to stop the
command.

Seek command

» Shortcut: <Ctrl+O>

 Button palette |:i"|

Result

Internal changes

Opening a project loads the project and its workspace. All the project entities are loaded.

Changes to the views

» Opening a project or workspace: all the modified files relative to the previous
workspace are prompted to save. The File View is updated.

« Opening a textual file (source or Tcl file): a view is opened in the result pane allowing
changes.

» Opening an html file: a view is opened in the result pane to visualize it.
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Possible errors

The following blocking errors may occur - due to Open dialog box entries:
+ The file does not exist.
» The user does not have read access to the file to be opened.

In all these cases, the dialog box remains opened even after clicking OK. The user must
enter another name or cancel the command.
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Open Workspace - File menu

Open an existing workspace

View

Can be launched from any view.

Context

Always available.

Usage
This command is used to open an existing workspace (.ttw).

If the previous workspace was modified and not saved, a dialog lets save it before
loading the new one (click Yes, No or Cancel).

Result

Internal changes

Opening a workspace loads the workspace and its project. All the project entities are
loaded.

Changes to the views

All the modified files related to the previous workspace are prompted to save. The File
View is updated.

Possible errors

See the Open - File menu command errors.
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Options - Files - Project menu

Allow to choose the most significant option file
View
Can be launched from any view.

Context

Available only when the option files associated to the project exist.

Dialog

An Option Files dialog is displayed and allows using the arrows to select the most
significant option file among all option files associated to the project. Click Ok to
validate or Cancel to ignore.

Result

The file at the top list level in the dialog box becomes the most significant for the project.
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Options - Save As - Project menu

Allow to save a project option in an option file

View

Can be launched from any view.

Context

Only available when a project is loaded.

Dialog

The Save As dialog box opens. Use this file browser to name a file to be saved. If an
existing file is selected, a warning is displayed: click ‘Yes’ to override the existing file,
or ‘No’ to cancel and come back to the Save As dialog box.

Then another dialog box prompts to include this new file in the project or not. Click Yes
or No.

Result

A new option file (suffixed by .tot) is created and appears in the File View project if Yes
has been selected. The project option (HTML tables or Java applets) is saved in this file.
Once added it can be suppressed from the project as any other file. Double-clicking on a
such file in the File View, activates the options editor which allows to change and save
options.

my_options.tot *

(=1

=0 Logiscope
B Preferences

----- {3 HTMLReports
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Options - Tools menu

Customize both Studio and HTML reports

View

Can be launched from any view.

Context

Always available.

Result

Customization will appear in the Logiscope session and HTML reports.

Dialog

A dialog box with several tabs is opened.
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» The General tab allows to customize Studio behaviour regarding display options.

el Pt

General ISave I Wn:-rkspan:el Fn:-rmatl Linkz I Huperlink, .ﬂ.dvancedl

[V Display status bar

[V Show output window when receiving content
[¥ Connect to the Source Contral Systern at startup
¥ Show advanced option page

Dizable external program launch for theze tppes of file:
I".t:-:t

] I Cancel Help

Display status bar: check/clear this option to show/hide the status bar.

Show output window when receiving content: check this option to show the output
window when receiving content.

Connect to the Source Code Control System at startup: this option is available only if
a source code control (SCC) system is installed. Check it to use the SCC system. If the
option value is FALSE, the SCC menu and toolbar are not available.

Show advanced option page: check this option to display an additional property page
(Advanced tab, described below) that displays all the options in a tree control.

Disable external program launch for these types of file: list in the field the file
extensions (separated by a semi-colon) to open within Studio and not with an external
program.
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« The Save tab allows to customize Studio behaviour regarding save options.

21|
General Save I Workzpace I Format I Linkz I Hyperlinl, I Advanced I
[¥ Sawve before running tooks

v Prompt before zaving files and projects

[T Automatic reload of externally modified files

Autozave
|7|_ Activate evern I = rinutes

| (] I Cancel | Help |

Save before running tools must be checked to automatically save the modifications
each time an external tool is launched.

Prompt before saving files and projects allows to ask question before saving files
before running tools. This choice is only effective if the previous Save option is also
checked, else it has no effect.

Automatic reload of externally modified files when a file included in a project is
modified outside Studio, it detects that the file has changed and prompts to reload it.
Checked not to be prompted.

Autosave

Activate: if this option is checked, autosave is activated by default every 10 minutes, but
this delay can be changed.

Every: allow to increase or decrease the autosave delay.
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» The Workspace tab allows to customize Studio behaviour regarding workspace
options.

Generall Save ‘Workspace IF::-rrnatI Linkz I H_I,Iperlinkl .-ﬁ.d'-.-'an-:eu:ll
[V Reload last workspace at startup
[ “wfammn on project file status change
Projects default lacation:
IE:'\DDcuments and Settingzhfrmabthbdy Documentzhto Projects I

k. I Cancel Help

Reload last workspace at startup: if this option is checked, the last workspace is
opened and loaded at startup.

Warn on project file status change: check this option to be warned when a project file
(*.ttp) access right passes to ReadOnly in order not to loose the changes.

Projects default location: fill this field with the projects default location path.
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« The Format tab allows to customize Studio behaviour regarding format options.

Generall Save I ‘Workspace Format I HTHML Hepnrtsl Metric Iimitsl .ﬁ.dvancedl

Category: Faont: Size
I | = [0 =
zdl
.lgl.ﬂ. — Calors
cfig
C Text Selection
Murnber
Operatar
Cormment
String
F.epword
Ewent ;I
Fareground: Background:
Sample | | | |
AaBbCcExYviz [ ALlomatic ¥ Automatic

| ] 4 I Cancel | Help |

The user can define a font and a size for each type of file and a color to display each type
of item in the file.
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» The Links tab allows to customize Studio behaviour regarding link options.

2 x|

Generall Save I Wu:urkspau:el Format  Links I H_I,lperlinkl .ﬁ.dvancedl

[T &ctive link end iz an active target, not an active source
v Automatically create links between modified objects and active link end

v Show livk indicators

(] I Cancel | Help |

Active link end is an active target, not an active source: check this option to consider
active end link as an active target.

Automatically create links between modified objects and active link end: check this
option to create links between modified objects and active link end.

Show link indicators: check/clear this option to show/hide the link indicators.
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» The Hyperlink tab allows to customize Studio behaviour regarding hyperlink
options.

Generall Save I "-.-'-.-"u:-rkspa-:el F-:urmatl Links  Hwperink .ﬁ.dvancedl

[T By defaul, make hyperlinks to a workspace element

| ] I Cancel Help

By default, make hyperlinks to a workspace element: check this option to make
hyperlinks to a workspace element, by default.

+ The HTML Reports tab allows a choice between Java Applets (not available on
UNIX) or HTML Tables in reports.
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Options il

Commaon  HTML Beports | Advanced

HTML reponts
’7 & Use Java Applets " Use HTML Tables

(0] | Cancel Help

« The Metric limits tab allows to give a limit to the PATH metric, this value is used as a
bound in computation algorithm to limit the time.

PATH:

MHate: These values are used as bounds in metne computation algonthms ta ot
the computation tinme.

Ok I Cancel Help

« The Advanced tab allows to edit the option values. MetricLimits and HTMLReports
items are set using the previous tabs.
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Gereral ! Save lworkspace ] Format ! HTML Reports 1 Metrc trits  Advanced J

Servess: Managess :
[T - | Files.} Reset
Patn 1 Value 1
EI-O Logiscope
EJ.E:J preferences
El--O Metricims
e L PATH 32767
€ SHTMLReports
L ObplayRep java
OK 1 Cancel Help
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Output - View menu

Display or hide the output window

View

Can be launched from any view.

Context

Always available.

Seek command

 Shortcut: <Alt+2>
 Pop-up menu on a toolbar

Result

The output window (it also includes the Messages, Build and Browse tabs) is displayed
or hidden, depending on whether it was hidden or displayed. A check box displayed
before the command name in the View menu, indicates the current state of the output
window: if the box is checked, the output window is currently displayed; if the box is not
checked, it is hidden.

When hidden, the output window will be displayed again when a command using it is
activated.
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Paste - Edit menu

Paste the content of the paste buffer (entities previously copied or cut)

View

Can be launched from any Textual View.

Context

The paste buffer must contain entities that can be pasted in the view.

Usage

Click in the target view at a convenient place (or select an entity in the File View) before
calling the Paste command.

Seek command

e Shortcut: <Ctrl+V>
» Pop-up menu

+ Button palette E

Result

Internal changes

The paste buffer is written in the Textual View.
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Previous Item - Button palette

Navigate up in the Browse tab of the Output window

View

Effective in the Browse tab of the output window.

Context

Items must be displayed in the Browse tab of the Output window.

Seek command
» Shortcut: <Shift+F4>

- Button palette =%

Result

This command allows to navigate in the Browse tab: it selects the item placed before the
highlighted item of the displayed list and opens the view associated with it (for example
the metric issued from Criteria or Factors tab).

If no item is currently selected, the command selects the last item of the list; when the
first item is reached, it is wrapped up around the list.

A click on a column header in the Browse tab sorts the list in ascending order.
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Print - File menu

Print or generate a print file of the current view

View

Can be launched from any view, except views of the Workspace View.

Context

Always available.

Seek command
* Shortcut; <Ctrl+P>

+ Button palette &

Dialog

This command displays a Print dialog box that allows to:
+ select a printer and modify its properties,

+ choose to print to a file (.prn); in this case a Print to File dialog box opens and lets
select the target file.

 choose to print the whole document or only some pages,
« specify the number of printed copies.

Click Cancel to stop the command or OK to validate.

Result

The content of the current view is printed.

Possible errors

Insufficient access rights to the selected file.
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Print Manager - File menu

Not applicable to Logiscope
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Print Preview - File menu

Display the current view before printing
View
Can be launched from any Textual View.

Context

Always available.

Result

A print preview is displayed in a separate window. Controls are provided to zoom and
scroll through the pages.
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Print Setup - File menu

Set the printer options

View

Can be launched from any view.

Context

Always available.

Result

The current printer name and options are displayed and can be modified.
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Project - Pop-up menu

Hide or display the Project bar

View

Can be launched from a toolbar.

Context

Always available.

Result

With a right click on a toolbar, a pop-up menu appears. The toolbar can be hidden or
displayed depending on its current state.

See Toolbars tab in Customize - Tools menu command.
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Properties - View menu

Display or modify an entity characteristics

View

Can be launched from the File View and from any html file.

Context

Requires the selection of the entity whose characteristics are to be displayed or modified.

Seek command
* Shortcut: <Alt+Enter>
* Pop-up menu

 Button palette |

Dialog

A Properties Box contains a tab for editing the entity characteristics (General). Once
modifications are entered, close the dialog box or press Return to validate or Esc to
cancel.

Properties of a workspace (File View):

Properties A

eneral |

M arne:

IM shrmitnd. vz

File:
ID:HF‘ngram FilezhT elelogichLogizcopehudity b strnind b st

No modification allowed.
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Properties of a project (File View):

Froperties

General I

Perzsizt Az

Il'w-'lstrminu:l.vsp

File:
ID Program Files\T elelogic L ogizcopetsamplezidudit b st

No modification is allowed.

Properties of a folder (File View):

Properties

General |

Falder name: ISDurce Files

File extenzions: IC

Once modifications are entered, close the dialog box, press Return to validate or Esc to
cancel.
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Properties of a textual file (File View):

[eneral I

Perzist A

|m-:|chinc. o

File:
|D:'\F'ru:ugrem Filez\T elelogichLogizcopehzamplesauditybd strmi

No modification is allowed.

For entities with no available properties, the following box is displayed:

Properties

Drefauilt |

Mo properties available

Result

Allowed modification causes a new display in the view.

Possible errors

An illegal modification causes an error message display: “The new value of PersistAs is
not correct”. Click OK to close the dialog box if any change has been done.
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Quality - Pop-up menu

Hide or display the Quality view
View
Can be launched from a tab in the Workspace View.

Context

Always available when an QualityChecker project is loaded.

Result

With a right click on the tab, a pop-up menu appears. The view can be hidden or
displayed depending on its current state.
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Quality - Criteria Level - Browse menu

Display the criteria values for the current project

View

Can be launched from any view.

Context

Only available when an QualityChecker project is loaded and built.
Seek command
 Button palette i

Result

This command displays the Criteria tab in the Workspace View. It gives the criteria
values for the current project.

A double click on a criterion opens its description in html format in the result pane.
A double click on a class or on a function opens its source file.

A double click on an item (application, class or function) in a criterion category displays
the Browse tab in the output window with metrics used in the quality model for the
related scope (Application, Class or Function).

A double click on a metric in the Browse tab opens its description in html format in the
result pane.

A click on a column header in the Browse tab sorts the list in ascending order.
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Quality - Factor Level - Browse menu

Display the factor values for the current project

View

Can be launched from any view.

Context

Only available when an QualityChecker project is loaded and built.
Seek command
+ Button palette ﬂ

Result

This command displays the Factors tab in the Workspace View. It gives the factor
values for the current project.

A double click on a factor opens its description in html format in the result pane.
A double click on a class or on a function opens its source file.

A double click on an item (application, class or function) in a factor category displays the
Browse tab in the output window with metrics used in the quality model for the related
scope (Application, Class or Function).

A double click on a metric in the Browse tab opens its description in html format in the
result pane.

A click on a column header in the Browse tab sorts the list in ascending order.
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Quality - Quality Report - Browse menu

Display the quality report for the current project

View

Can be launched from any view.

Context

Only available when an QualityChecker project is loaded and built.

Seek command
* Shortcut; <F9>

 Button palette @|
Result

This command opens the Quality Report in the result pane. The links in html format
allow access to quality elements related to the project:

« the value and the description of factors, criteria and metrics for application, class and
function scopes,

« the list of source files.

Note: The report is generated in the tmp and is deleted when the report window is closed,
but it can be saved using the "Save As" command.
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Rebuild all - Project menu

Regenerate all results (output and files) for the active project

View

Can be launched from the File View.

Context

Always available.

Seek command
* Shortcut; <F7>

+ Button palette |

Result

This command generates results (output and files) for the active project. Even if the
project has already been built, this forces a rebuild of the entire project. The options used
to generate are those of the active configuration (see the Settings... - Project menu
command for more details). The output files are generated in the project directory.

Note: consult Kalimetrix Logiscope RuleChecker & QualityChecker Getting Started and
Kalimetrix Logiscope TestChecker Getting Started for more information on the
generation.
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Recent Files - File menu

List the last eight files used and allow to choose a file to open in this
list

View

Can be launched from any Textual View.

Context

Always available.

Result

The chosen file is opened in the result pane.

Studio Commands 125



Kalimetrix Logiscope

Recent Workspaces - File menu

List the last eight workspaces used and allow to choose a
workspace to load in this list

View

Can be launched from any Textual View.

Context

Always available.

Result

The chosen workspace is loaded.
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Redo - Edit menu

Restore a previously undone action

View

Can be launched from all views.

Context

Available after the Undo - Edit menu command.

Note: if an action has been performed after the Undo command, the Redo command is
no longer available.

Seek command
» Shortcut: <Ctrl+Y>
* Pop-up menu

 Button palette o

Result

The last actions canceled with the Undo command are restored.
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Refresh - Button palette

Reload an HTML page

View

Can be launched from the Script Wizard or an HTML view.

Context

Always available.
Seek command

+ Button palette

Result

The current page is loaded again and the display is refreshed.
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Replace - Edit menu

Find a character string and replace it by another one

View

Can be launched from a Textual View.

Context

Always available.

Seek command

Shortcut: <Ctrl+H>

Dialog

A dialog box is opened. It contains the following fields:

Find what to enter the character string to be searched; a scrolling list containing the
previous searched strings also allows to choose one of them without re-entering it. If a
string was selected in the text before starting the command, this string appears in this
field.

Replace with to enter the replacement for the searched character string; a scrolling
list containing the previous replacement strings also allows to choose one of them
without re-entering it.

Match whole word only: select it to search isolated occurrences of the string only.
Match case: select it to discriminate between uppercase and lowercase characters.

Replace In: select Selection to limit the find and replace operation to the previously
selected text; select Whole file to use the “find and replace” method in the whole
document.

The dialog box contains the following buttons:

Find Next to find the next occurrence of the string.

Replace to replace the current occurrence and find the next occurrence of the string.
Replace All to replace all occurrences.

Cancel to cancel the command.
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Revert - File menu

Revert to the previous state of the file

View

Can be launched on any file.

Context

Always available.

Result

The previous state of the file is restored and the display is refreshed.
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Rule - Rule Violations - Browse menu

Display the rule violations for the current project

View

Can be launched from any view.

Context

Only available when a RuleChecker project is loaded and built.

Seek command

 Button palette ¥|

Result

This command displays the Violations tab in the Workspace View. It gives the violated,
the clean (not violated) and ignored rules for the current project.

A double click on a rule opens its description in html format in the result pane.

A double click on a violated line opens the corresponding source file and highlights the
violation.
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Rule - Rule Violations by Files - Browse
menu

Display the rule violations by files for the current project

View

Can be launched from any view.

Context

Only available when a RuleChecker project is loaded and built.

Result

This command displays the File Violations tab in the Workspace View. It displays the
files in the current project where the violations occurred.

A double click on a rule opens its description in the result pane.

A double click on a violated line opens the corresponding source file and highlights the
violation.
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Rule - Rule Violations List - Browse menu

Display the rule violation list for the current project

View

Can be launched from any view.

Context

Only available when a RuleChecker project is loaded and built.

Seek command

 Button palette 1‘='£|

Result

This command displays the rule violation list in the Browse tab of the output window. It
gives for each rule the violations location (line).

A double click on a violated line opens the corresponding source file and highlights the
violation.

A click on a column header in the Browse tab sorts the list in ascending order.
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Rule - Rule Violations Report - Browse
menu

Display the rule violation report for the current project
View
Can be launched from any view.

Context

Only available when a RuleChecker project is loaded and built.
Seek command
+ Button palette @

Result

This command displays the rule violation report in the result pane the links in html
format allow access to violations by file and by rule for the current project.

Note: The report is generated in the tmp and is deleted when the report window is closed,
but it can be saved using the "Save As" command.
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Save - File menu

Save the selected file and associated files

View

Can be launched from the File View.

Context

A file (.ttw, .ttp or textual) must be selected.

Seek command
» Shortcut; <Ctrl+S>

 Button palette =

Result
« If atextual file is selected, only this file is saved.

« If a workspace is selected, this command is equivalent to the Save Workspace -
File menu command (the workspace, its projects and all the modified Kalimetrix
Logiscope files are saved).

» Ifaprojectis selected, it is saved as well as all the modified Kalimetrix Logiscope
files.

Possible errors

One file cannot be write accessed. A message is displayed in an Error box. The
command is canceled.
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Save All - File menu

Save all modified files

View

Can be launched from any view.

Context

A workspace is opened.

Seek command

- Button palette G|

Result

All modified files of the current workspace are saved.

Possible errors

One file cannot be write accessed. A message is displayed in an Error box. The
command is canceled.
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Save As - File menu

Save a description in a new file

View

Can be launched from any Textual View.

Context

Always available.

Seek command

* Pop-up menu

Dialog

The Save As dialog box opens. Use this file browser to name a file to be saved. If an
existing file is selected, a warning is displayed: click “Yes’ to override the existing file,
or ‘No’ to cancel and come back to the Save As dialog box.

Result

The current description is saved in the designated file. This command has no impact on
the current project: the new file is not referenced by the current project (meaning this
command can be seen as an export command).

Possible errors

The designated file cannot be write accessed. A message is displayed in an Error box.
The command is canceled.
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Save Workspace - File menu

Save the current workspace

View

Can be launched from any view.

Context

A workspace is opened.

Result

The current workspace, its projects and all modified Kalimetrix Logiscope files are
saved.

Note: The workspace and the projects are saved even if no change is made.

Possible errors

One file cannot be write accessed. A message is displayed in the Error box. The
command is canceled.
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Open the Script Wizard

View

Can be launched from any view.

Context

Always available.

Seek command
« Shortcut: <Ctrl+W>

 Button palette AN

Result

Kalimetrix Logiscope

This command opens the Script Wizard that allows to navigate in the UML
representation of a Kalimetrix Logiscope model and to create Tcl scripts to extract
information from the model (for more details see paragraph 2.17, Script Wizard).
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Select All - Edit menu

Select all entities in the current Textual View
View
Can be launched from a Textual View.

Context

Always available.

Seek command
* Shortcut; <Ctrl+A>
* Pop-up menu

Result

All current view entities are selected.
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Select from Properties - Browse menu

Allow to select classes or methods/functions for the current project
according to a criterion or a factor evaluation degree

View

Can be launched from any view.

Context

Only available when an QualityChecker project is loaded and built. If in a multi-project
context, only the active (currently selected) project is considered.

Result

This command displays a User Request tab in the Workspace View. It gives for the
current project the list of classes or methods/functions for the chosen criterion or factor
evaluation degree.

A double click on a class or on a method/function opens its source file in the result pane
and its metrics values in the Browse tab of the output window.

A double click on a metric in the Browse tab opens its description in html format in the
result pane.

A click on a column header in the Browse tab sorts the list in ascending order.

Note: make as many requests as needed by adding them in the User Request tab or by
creating a new tab.
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Settings... - Project menu

Set current tool options for the current project and configuration
View
Can be launched from any view.

Context

A project is active.

Seek command
* Shortcut: <Alt+F7>

Dialog

A Settings dialog box opens. It displays the project settings with several tabs depending
on the type of the selected project: i.e. the programming language and the applicable
Logiscope verification modules.

E; Logiscope CodeReducer ] Clutpat ] QualityChecker ] Apalysiz ]
- Mastermind. ttp General l Modues | PRuleSet | FRues | Advanced |
=25 Quality Model )
@ Logiscope. ref General zettings
-3 Flule Set _ _
T Mastermind.rst Logizcope repoziton:
-5 Source Files |I::"uLl:ngisc-:upeF'rl:uiects'xMastermind'xL-:ugiscnpe
| baze.c

maching. o Source files suffines [all cateqaries]:

rmaster.c |".n:;“.E
plaver.c

FCOME.C

util.c

ke, c

More information on project settings are available in Kalimetrix Logiscope RuleChecker
& QualityChecker - Getting Started and Logiscope TestChecker - Getting Started.
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Shortcuts - View menu

Display or hide the Shortcuts
View
Can be launched from any view.

Context

Always available.
Seek command
 Pop-up menu on a toolbar

Result

Shortcuts are displayed or hidden, depending on whether they were hidden or displayed.
A check box displayed before the command name in the View menu indicates the current
state of the Shortcuts: if the box is checked, they are currently displayed; if the box is
cleared, they are hidden.
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Small Icons - Pop-up menu

Reduce the size of the icons in the Shortcuts View
View
Can be launched from the Shortcuts View.

Context

Always available.

Result

A pop-up menu appears when right-clicking in a shortcut list. The selection of the Small
Icons option allows to display the icons of the list as small icons.
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Source Control - Pop-up menu

Hide or display the Source Control bar

View

Can be launched from a toolbar.

Context

Always available.

Result

With a right click on a toolbar, a pop-up menu appears. The toolbar can be hidden or
displayed depending on its current state.

See Toolbars tab in Customize - Tools menu command.
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Source Control - Add to Source Control —
Project menu

Add an item into the source code control system

View

Can be launched from a file or a folder.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command
+ Button palette
» Pop-up menu on a file or a folder

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Check In - Project menu

Save an item into the source code control system

View

Can be launched from a file or a folder.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command

+ Button palette
» Pop-up menu on a file or a folder

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Check Out - Project menu

Restore an item from the source code control system

View

Can be launched from a file or a folder.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command

+ Button palette
» Pop-up menu on a file or a folder

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Get lastest version -
Project menu

Get the lastest version of an item in the source code control system

View

Can be launched from a file or a folder.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command

 Button palette
 Pop-up menu on a file or a folder

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Import from Source
Control - Project menu

Import from the source code control system

View

Can be launched from any view.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command
+ Button palette

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Refresh Status - Project
menu

Refresh status according to the source code control system

View

Can be launched from any view.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command
 Button palette

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Remove from Source
Control - Project menu

Remove an item from the source code control system

View

Can be launched from a file or a folder.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command

+ Button palette
* Pop-up menu on a file or a folder

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Show Differences -
Project menu

Show differences on an item between its current state and its state in
the source code control system

View

Can be launched from a file or a folder.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command

 Button palette
» Pop-up menu on a file or a folder

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Show History - Project
menu

Show an item’s history archived in the source code control system

View

Can be launched from a file or a folder.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command
+ Button palette
* Pop-up menu on a file or a folder

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Source Control - Project
menu

Execute the source code control system
View
Can be launched from any view.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command
 Button palette

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Source Control
Properties - Project menu

Display the properties of the source code control system
View
Can be launched from any view.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command
+ Button palette

Result

The source code control system is invoked and the requested action is executed.
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Source Control - Undo Check Out - Project
menu

Undo the operation in the source code control system

View

Can be launched from a file or a folder.

Context

Always available when a source code control system is installed on the machine and if
the "Connect to the Source Code Control System at startup™ option is checked (see
General tab in Options - Tools menu).

Seek command

 Button palette
» Pop-up menu on a file or a folder

Result

The source code control system is invoked and the requested action is executed.
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Standard - View menu

Display or hide the Standard toolbar

View

Can be launched from any view.

Context

Always available.

Seek command

* Pop-up menu on a toolbar

Result

The Standard toolbar is displayed or hidden, depending on whether it is hidden or
displayed. A check box displayed before the command name in the View menu, indicates
the current state of the toolbar: if the box is checked, the toolbar is currently displayed; if
it is cleared, the toolbar is hidden.
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Start Link - Link menu

Allow to define a link on an object

View

Can be launched from a file or a folder.

Context

Always available (even if the object has already some links).

Seek command

« Pop-up menu on the object
 Button palette
+ Shortcut: <Ctrl+K>

Result

Kalimetrix Logiscope

A dialog window is opened, allowing to define a link on the object.
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Start Many Links - Link menu

Allow to make many links from start

View

Can be launched from any view.

Context

Available if not already active.

Seek command
+ Button palette

Result

This command allows to make links from start. Once it is activated, it is replaced by the
Clear Start Many Links command and allows the access to the Make Link from Start
command in the Link menu.

The Clear Start Many Links command restores the initial state.
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Start TestChecker - Project menu

Start Kalimetrix Logiscope TestChecker

View

Can be launched from any built project.

Context

Only available for a TestChecker built project.

Seek command

 Button palette @

Result

This command launches TestChecker.
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Start Viewer - Project menu

Start Kalimetrix Logiscope Viewer

View

Can be launched from any built project.

Context

Always available for a built project except for a RuleChecker project.

Seek command

+ Button palette [

Result

This command launches the Viewer.
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Stop - Button palette

Stop the loading of an HTML page

View
Can be launched from the Script Wizard or an HTML view.

Context
A page is being loaded.

Seek command
+ Button palette @

Result

This command interrupts a page loading.
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Stop - Project menu

Stop the execution of the build command

View

Can be launched from any view.

Context

Only available during a Build command execution.
Seek command

+ Button palette ﬂ

Result

This Build command is stopped and the following message is displayed in the output
window (Build tab): Build canceled by user.
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Style - Tools menu

Not available
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Tcl Script - Pop-up menu

Hide or display the Tcl Script bar

View

Can be launched from a toolbar.

Context

Always available.

Result

With a right click on a toolbar, a pop-up menu appears. The toolbar can be hidden or
displayed depending on its current state.

See Toolbars tab in Customize - Tools menu command.
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Kalimetrix Direct Contact - Help menu

Display Kalimetrix Logiscope feedback

View

Can be launched from any view.
Context
Always available.

Result

An html file containing links to contact Kalimetrix directly or to get information on
products is displayed.
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Test - Component Coverage - Browse
menu

Display tested components with DDPs

View

Can be launched from any view.

Context

Only available when a TestChecker project with a dynamic result file is loaded.

Seek command

« Button palette “&

Result

Components are listed in the Browse tab of the output window with their DDP coverage
and the corresponding test.

A double click on a line in the Browse tab displays the corresponding source file in the
result pane.

A click on a column header in the Browse tab sorts the list in ascending order.
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Test - Test Report - Browse menu

Display the test report for the current project

View

Can be launched from any view.

Context

Only available when a TestChecker project with a dynamic result file is loaded.

Seek command

 Button palette @|

Result

This command opens the test report in the result pane.

Note: The report is generated in the tmp and is deleted when the report window is closed,
but it can be saved using the "Save As™ command.
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Tests - Pop-up menu

Hide or display the Tests view
View
Can be launched from a tab in the Workspace View.

Context

Always available when a Test project is loaded.

Result

With a right click on the tab, a pop-up menu appears. The view can be hidden or
displayed depending on its current state.
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Tile Horizontally - Window menu

Arrange windows as non horizontally overlapping tiles
View

Can be launched from any view.

Context

Always available.

Result

When the windows are horizontally tiled, Studio displays entirely each window - no
windows overlapping. All windows are resized as necessary to fit inside the result pane.
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Tile Vertically - Window menu

Arrange windows as non vertically overlapping tiles
View
Can be launched from any view.

Context

Always available.

Result

When the windows are vertically tiled, Studio displays entirely each window - no
windows overlapping. All windows are resized as necessary to fit inside the result pane.
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To Shortcut - Pop-up menu

Convert a toolbar into an embedded listbar in the Shortcuts View

View
Can be launched from Logiscope toolbar.

Note: The Menu, Standard, Browse, Tcl Script, UML Browser and Project bars cannot be
converted into Shortcuts View.

Context

Always available.

Seek command

« Pop-up menu on the Logiscope toolbar

Result

A pop-up menu appears with a right-click on a toolbar. The selection of the To Shortcut
option allows to display the toolbar as a shortcut list.

To display the shortcuts as a toolbar again, click right and choose the As Toolbar -
Pop-up menu option.
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Undo - Edit menu

Cancel a previous action

View

Can be launched from any view.

Context

Always available, providing that at least one editing action has been performed.

Seek command
« Shortcut: <Ctrl+Z>
* Pop-up menu

+ Button palette o

Result

The previous action is canceled. The previous internal context and the previous
concerned view are restored. If a view is closed after actions have been performed in it,
the actions can be undone but the view is not opened again.

The Undo command can be launched as many times as there are previously performed
actions.

Actions involving file saving cannot be undone.

Use the Redo - Edit menu command to restore undone actions.
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Web - Pop-up menu

Hide or display the Web bar

View

Can be launched from a toolbar.

Context

Always available.

Result

With a right click on a toolbar, a pop-up menu appears. The toolbar can be hidden or
displayed depending on its current state.

See Toolbars tab in Customize - Tools menu command.
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Workspace - View menu

Display or hide the Workspace Window

View

Can be launched from any view.

Context

Always available.

Seek command
+ Shortcut: <Alt+0>
* Pop-up menu on a toolbar

Result

The Workspace View (which includes the File View tab) is displayed or hidden,
depending on whether it is hidden or displayed. A check box displayed before the
command name in the View menu indicates the current state of the workspace area: if the
box is checked, the window is currently displayed; if cleared it is hidden.
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Quality Model Editor

4.1

Kalimetrix Logiscope

Chapter 4

Starting the Quality Model Editor

The Quality Model Editor allows to display and modify the Quality Model used for a
Logiscope QualityChecker project.

With Logiscope Studio, load or create a QualityChecker project. Double-click on the
Quality Model file in the project workspace. The Quality Model Editor is displayed
together with the metrics, criteria and factors used in the Quality Model for the required

language.
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Default Quality Model files are supplied: e.g. Logiscope.ref in the Ref folder of the
Logiscope standard installation directory.
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4.2 Overview of Quality Model Editor

Views

When the quality model editor is activated, three windows are displayed in the result
pane:

+ [Factor] quality editor,

* [Criteria] quality editor,

» [Metric] quality editor.

With the use of these editors, all the existing items in the quality model can be modified
and new items can be added.

[Factor] quality editor

v [Factor] MAINTAIMABILITY =10 x|

ﬁLanguage C++ Scope  Clazs

i ame

I-:Iass_M.-‘l‘-.I MTAINABILITY

D'escription

Clazs MAINTAIMNABILITY: Charactenstics used to assess
the effart required to make given modifications.

Expreszion
clazz AMALTYZABILITY + class CHAMGEABILITY + clazz STABILITY + clasz TESTABILITY I, |
Categaries:
I ame | kin | [ |
B EXCELLENT 12 12
& GOOD S 11
& FAIR 4 7
& POOR ] K]

There are four main user definable areas:
« Name: contains the name of the factor item.
+ Description: contains a comment about the factor item.
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» Expression: contains the expression used to calculate the factor item. To modify this
area, the expression editor must be used. This editor is opened with the ﬁl button.

Expression Editor

E =prezzian;
Iclass_.-’-‘-.N.-’-‘-.L“r’Z.ﬂ.BlLlTY + clasz CHAMGEABILITY + clazs_STABILITY + ol

Operatore #

Check. V

Operands » Cancel |

Operands and Operators displays a pop-up list of all the criteria items and
operators that are available to construct the required factor level expression.

Check can be selected to verify the syntax of the edited expression. Any errors
found are displayed in the output window of Studio.

OK updates the expression area in the [Factor] window.

» Categories: contains the evaluation degrees together with their maximum and
minimum values. These values can be modified by selecting the value with the left
mouse button.

If conflicting values are selected, an error is displayed in the output window.

Cateqaries:
M ame | bdin i I
T EXCELLENT 12 |12
& GOOD 17 11
T Fale M —p
¢ POOR 0 3
New evaluation degrees can be added to the categories list with the use of the
Insert key and can be deleted with the use of the Delete key. Renaming is also
possible by clicking twice on the evaluation degree.
Categornies:
M arne | kdir | hd 3w | -
0 EXCELLENT 12 12
e GOOD g 11
P AVERAGE 4 7 —
IR Categony_1 p c! ll

Note: To add new evaluation degrees, there must be a Min/Max gap between the
evaluation degrees where the insertion is required.
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[Criteria] quality editor

[Criteria] TESTABILITY - 10| x|

ﬁ? Language C++ Scope  Funchion lzed By
- @ Factors
Marne o function_MAINTAIMABILITY
|func:tiu:|n_TEST.-'1'«E!ILITY
Drezcription

Function TESTABILITY : Charactenstics of the source code
which are uzed to azsess the effort neceszan to
validate the modified software

E xprezzion

de_calls + LEVL + ct_path + ic_param @q |
Categories:

M ame | kdin | G | YWiEl.. |

A+ EXCELLENMT 4 4 a

e GOOD 3 3 2

A FAIR 2 2 1

42 POOR 1] 1 1]

[There are five main user definable areas:

« Name: contains the name of the criteria item.

» Description: contains a comment about the criteria item.

+ Used By: displays all the factor items that use the criteria item in question.

» Expression: contains the expression used to calculate the criteria item. To modify this

area, the expression editor must be used. This editor is opened with the ﬁl button.

Expression Editor

E xprezzion:

Iu:h:_u:alls + LEYL + ct_path + ic_param

Operators ¥

Check ' i ¥
Operands ¥ Cancel |

Operands and Operators displays a pop-up list of all the metric items and
operators that are available to construct the required criteria level expression.
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Check can be selected to verify the syntax of the edited expression. Any errors
found are displayed in the output window of Studio.

OK updates the expression area in the [Criteria] window.

« Categories: contains the evaluation degrees together with their maximum, minimum
and weight values. These values can be modified by selecting the value with the left
mouse button.

Cateqaories:
I amne | ki R E |Wei... |
B EXCELLENT 4 j 4 4
& GOOD 3 3 K]
& FAIR E 2 2
& POOR n 1 1

 Evaluation degrees can be added, deleted and renamed. See [Factor] quality editor
for a full explanation.

[Metric] quality editor

I [Metric] A¥GS: Average size of statements - II:I|5|
ﬁ?Language C++ Scope  Function

kM nemanic

I.-’-'-.‘-.I“GS

M ame

Dezcription

I.ﬁ.verage gize of statements

|lzed By

T Metrics
-8 Criteria
e function_AMALYZARILITY
=-§@ Factors

o function_MAINTAINABILITY

Drefirition:

where:

E =pression

e
Thiz metric [&Verage Size of statements] coresponds to the average number
of operandz and operators uged by each of the function's executable statements.

[t iz calculated as folloves:
AMGES = [MT1+M2] 4 [lo_stat);

M1 iz the number of operator oocurences.

JINT + N2) £ le_stat

Lirmtz

Tupe
IFI:::at vI

kdin

i

|1.00

|5.00

There are six main user definable areas:
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* Mnemonic: contains the mnemonic of the metric item.

» Name: contains the full name of the metric item.

» Description: contains a comment about the metric item.

« Used By: displays all the factor and criteria items that use the metric item in question.
» Expression: contains the expression used to calculate the metric item. To modify this

area, the expression editor must be used. This editor is opened with the ﬁl button.

Note: the expression area and expression editor are disabled for basic metric
items.

Expression Editor

E wprezzion:
[INT + M2 7 le_stat

Operators #

Check @
Operands ¥ Cancel |

Operands and Operators displays a pop-up list of all the metric items and
operators that are available to construct the required metric level expression.

Check can be selected to verify the syntax of the edited expression. Any errors
found are displayed in the output window of Studio.

OK updates the expression area in the [Metric] window.

 Limits: contains the type, together with its maximum and minimum, that can be used
with the selected metric.
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Mew Application Fackor

Mew Class Factor

MNews Funickion Fackor

Mew Application Criteria
Mew Class Criteria

MNews Function Criketia

Mew Application Metric
Mew Class Metric

MNews Funckion Metric

Properties. .. &lk+Enker

El

|_:_|¢> C++
=- 43 Factor
E| 'a Application
..... e ApplicationFactor_1
i i MAINTAINABILITY
E| 'a Class
----- i MAINTAIN_1
R . # REUSABILITY
E| 423 Function
----- i MAINTAINABILITY
----- i relativeCal_MAINTAINABILITY
=43 Criteria
= 'a Application
P ANALYZABILITY
------ 4 CHANGEABILITY
------ 4 STABILITY
o TESTABILITY
- |:| Class
=23 Function
----- @ ANALYZABILITY
----- & CHANGEABILITY
----- & relativeCal_AMALYZABILITY
----- ° relativeCall_STABILITY
----- & relativeCal_TESTABILITY
----- & STARILITY
----- & TESTABILITY
=23 Metric
#-(C Application
#-(] Class
& Function
Fileiew | B Quality

This quality view presents all the factor, criteria and metric items used for each language
scope. The following actions can be performed on these items:

Add

New items can be added to the quality model. This is done by selecting a location in the
quality view with the right mouse button. A pop-up menu is displayed with a list of item
types that can be added. The items in the menu list are dependent on the cursor location.

When a new item is added, a corresponding blank editor window is displayed in the
result pane. Modifications in this editor window can be performed as described above.
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Delete

Existing items can be removed from the quality model. This is done by selecting the item
in the quality view and pressing the Delete or Backspace keys. The item is removed
from the quality view and the corresponding editor is cleared.

Only items with no links to other items can be deleted. For example, the item Criteria-
Application-ANALYZABILITY can only be deleted if Factor-Application-
MAINTAINABILITY is deleted first.

Rename

Existing items can be renamed in the quality model. This is done by clicking the item
twice. Modification to the name in the quality view are duplicated in the corresponding
editor window.
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Appendix A

Data Model

A.l

A.2

Introduction

The Kalimetrix Logiscope API (Application Programming Interface) is based on a data
model as described below. This UML metamodel describes the project structure and
Logiscope entities. To see Logiscope data model, browse through Script Wizard. This
function allows to create or adapt Tcl scripts to customize interface or generated results
(for more details on the Script Wizard function see Section 2.17).

At first the symbols used in a data model representation will be explained. Then the data
model itself will be shown in graphic form and in text format.

Examples of Tcl scripts using the Logiscope API as described in Appendix A can be
found in the <log_install_dir>/Scripts directory.

Concepts and symbolism

A data model is represented as a class diagram. Here is the definition and representation
of object-oriented concepts appearing in graphic form in a data model.

A.2.1 Class

A class is a set of objects with similar properties (attributes), common behaviors
(operations) and share relations with other objects.

class1

attribute1: type
attribute2: type

operation1(): type
operation2(): type
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A.2.2 Attribute

An attribute is a data item specific to objects of a given class. Each attribute name is
unique in its class. Each attribute has a value of the specified type (string, integer, etc.)
for every object instance.

A.2.3 Operation

An operation is a function or a transformation that can be applied to objects of a class or
carried out by them. All the objects in a given class share the same operations. The type
associated to an operation indicates the type of value returned by the operation.

A.2.4 Link and association

class1

attributel ..
attribute? ...

class?

operation1 ...
operation? ...

A link is a physical or conceptual connection between two instances of an object:

association name

« A-to-B link and B-to-A link:

i

« A-to-B link only (the origin side of the link is indicated by the exclamation point !):

An association describes a set of links just as a class describes a set of objects.
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A.2.5 Multiplicity

The multiplicity specifies the number of class instances related to an instance of the

associated class. Multiplicity (or cardinality) can be a range of values, a set of values or a
specific number.

» 1instance of A is linked to 0 or 1 instance of B:

A ) B

» 1 instance of A is linked to O or more instances of B:

a q B

« linstance of A is linked to at least n instances of B (n > 0):

n+
A B

« 1linstance of A is linked to a number of instances of B between m and n inclusive:

m-n

A.2.6 Role

A role is one end of an association. A binary association has two roles, each with its own
name. The name of a role is a name that clearly identifies one end of an association.
Roles make possible to consider a binary association as the link of one object to an
associated set of objects. Each role in a binary association identifies an object or set of
objects associated with an object at the other end.

class1 class2
attributel ... rolel role2
attribute2 ...
operationt ... association name
operation? ...

The name of a role is a derivative attribute whose value is a set of associated objects.

There are two cases for which roles must absolutely be named:
* recursive associations,
« several associations involving the same classes.

If roles are not named, the class name is taken as the role name, with the first letter
changed to lower-case.
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A.2.7 Inheritance

The “is a kind of” relation allows classes to share similarities and retain their differences.

A
B1 B2 B3
A.2.8 Abstract class
{A
B1 B2 B3

An abstract class is a class with no instantiated objects. Attributes and operations it
describes are inherited by its sub-classes.
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CtxtObject

code : string
line : integer
start : integer
length : integer

Component

Statement

| RuleViolation |

name : string

crc : integer

date : string

listEntries : CStringList

kind : integer
num : integer

instruction : string

Decision
notOperator : boolean
decisionNumber : integer

GetMetricValue(metric : Metric) : real
EvaluateComputedMetrics()
GetBasicMetricValue(basicMetric : BasicMetric) : real
GetCriteriaValue(criteria : Criteria) : CriteriaCategory
GetFactorValue(factor : Factor) : FactorCategory
EvaluateFactors()

EvaluateCriterias()

EvaluateQualityModel()

IsExternal() : boolean

GetLanguageName() : LPCTSTR

IsMcdc() : boolean
condCount() : integer

Figure 2 ContextObject diagram
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Object

File
/fileName : string
pathName : pathname

Project
StaticFile DynamicFile SourceFile - -
creationDate : string

version : string crc : integer
date : string
lineCount : integer

dataDirectory : CPathName
buildCmd : string

buildArgs : string
testDirectory : CPathName
binaryArgs : string

binary : string

binaryType : boolean
sourceDirectory : CPathName

QualityModelFile

version : string

Load() : integer

Save() : integer

FindSourceFile(pathName : string) : SourceFile
EvaluateQualityModel()

GetQualityModel() : QualityModel
FindStaticFile(pathName : string) : StaticFile

FindQualityModel(language : Language) : QualityModel
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binary : string

sourceDirectory

creationDate : string
dataDirectory : CPathName
buildCmd : string

buildArgs : string
testDirectory : CPathName
binaryArgs : string

binaryType : boolean

Load() : integer
Save() : integer

EvaluateQualityModel()
GetQualityModel() : QualityModel

DynamicFile

version : string

Include

* [ includes

Rule
name : string
key : string QualityModel
ruleState : string 0.1
0.1
, . 1
Project name : string Component
name : string
crc : integer 1
date : string
name : string 1 |iistentries : CStringList
GetMetricValue(metric : Metric) : real
EvaluateComputedMetrics()
0 GetBasicMetricValue(basicMetric : BasicMetric) : real
. T GetCriteriaValue(criteria : Criteria) : CriteriaCategory
: CPathName GetFactorValue(factor : Factor) : FactorCategory
1
& EvaIuateFa_cto_rs()
EvaluateCriterias()
FindSourceFile(pathName : string) : SourceFile 1 EvaluateQualityModel() 0.1
«|IsExternal() : boolean
GetLanguageName() : LPCTSTR
FindStaticFile(pathName : string) : StaticFile
¢ x
1 1| crtbomain name : strina
ApiDomain
dirty : boolean
0.1 MetricValuePresent(component : Component,metric : Metric,pfVal : void *) : boolean
Language GetCriteriaCategory(component : Component,criteria : Criteria) : CriteriaCategory
*| included = . 1 GetFactorCategory(component : Component,factor : Factor) : FactorCategory
S il * InvalidateContext()
ourcerile SetMetricValue(component : Component,metric : Metric,val : real) : boolean
crc : integer
date : string 01 - -
lineCount : integer [~ 0.1 QualityModelFile
“=version : string

FindQualityModel(language : Language) : QualityModel
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Relation

*

from

Component

relationKind

Inheritance

Child

Friend

Other

name : string

name : string

cre : integer

date : string

* |listEntries : SStringList

to

Use

Call

componentKind
| | |
FctComponent Application Module
scope : string
type : integer
[ |
Function Method
acces : integer
i Class .
seedny scope strmg child
classSig : string
type : integer
* | uses * | parent
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* | called

FctComponent

scope : string

*

*

numDDP : integer

{ordered}destinationBranch

1 ’ type : integer calling
Call fctCompSig : string
* GetDDPsCount() : integer
GetDDPCovered(i : integer,stat : StatementExec) : boolean
0..1 |next
*
Callinstance Decision
numcCall : integer 0.1 notOperator : boolean
line : integer up decisionNumber : integer 0.1
1 IsMcdc() : boolean previous
% 0 condCount() : integer
Statement 0.1 | down
1likind : integer 1
destination |num : integer jump
— instruction : string . *
destination J—
IESAJ
statementKind *
* 1\/end
StmtJump StmtSequence | StmtCtrl | 1
label : string stmtCount : integer ’ start
instrJump : integer 1| sre
* | srcBranch
Branch

BooleanOperator

kind : integer
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BaseExpr

/\

exprKind

value : real 0.1
Evaluate(component : Component) : real rightExpr
ResolveDependencies(qualityModel : QualityModel)
CheckScope(qualityModel : QualityModel) : integer 0.1
leftExpr

IdentifierExpr

ConstExpr mnemonic : string

*

1

'

1

'

Metric

1

byVal : boolean depends

identKind

name : string

num : integer
comment : string
min : real

max : real

type : integer
mnemonic : string
visualMnemo : string

metric

1

BinaryExpr

operator : string

Evaluate(component : Component) : real

criteria

MetricExpr

CriteriaExpr

Evaluate(component : Component) : real

Evaluate(component : Component) : real

Criteria

name : string
comment : string
num : integer
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QualityObject

name : string

comment : string
num : integer

qualityobjectKind

formula

Factor

Criteria

QualityModelFile

version : string

QualityModel

FindQualityModel(lang..

1%

criteriaDepends

criteriakind

torDepends

JA)

factorKind

ClassFactor | |

FunctionFactor

ClassCriteria | |

FunctionCriteria

Metric

min : real
max : real
type : integer

Language

name : string

mnemonic : string
visualMnemo : string

| ApplicationFactor

| | ModuleFactor

| ApplicationCriteria |

| ModuleCriteria |

metricDepends

metricKind

ClassMetric | |

FunctionMetric

| ApplicationMetric | |

ModuleMetric
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QualityModel

Metric

min : real

max : real

type : integer
mnemonic : string
visualMnemo : string

0"1\l ApplicationMetric

- - B ([FunctionMetric]metric) 0..1
mnemonic : string | ) )
functionMetric FunctionMetric

1 ([ClassMetric]metric) 0..1] -

mnemonic : string | =1 ClassMetric
classMetric

B ([ApplicationMetric]metric)

mnemonic : string |
applicationMetric

B ([ModuleMetric]metric)

mnemonic : string |

moduleMetric |

ModuleMetric

adoasibo xinawiey



[enuey soualaay oipnS 8doasiBoT Xuwiey yT-V

welbelp sdep elL111D 0T 94nbi4

QualityModel

Criteria

name : string

e

name : string

———
name : string

1

(IModuleCriterja]criteria)

—|{[FunctionCriteria]criteria) 0..1 - —
FunctionCriteria
functionCriteria
1 ([ClassCriterig]criteria) 0..1
ClassCriteria
classCriteria
1 ([ApplicationCriteria]criteria) 0..1 — —
ApplicationCriteria
applicationCriteria

0.

1

———
name : string

moduleCriteria

ModuleCriteria
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QualityModel

—éﬁEunctionFactor]factor)

0..1

name : string

— ([ClassFactor]factor)

functionFactor

FunctionFactor

0..

1

name : string

classFactor

1 ([ApplicationFactor]factor)

ClassFactor

0..1

Factor

]
name : string

—

(IModuleFactor]factor)

applicationFactor

ApplicationFactor

0..1]

name : string

moduleFactor

ModuleFactor
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Criteria

name : string
comment : string
num : integer

CriteriaCategory

Factor

name : string
comment : string
num : integer

name : string
min : integer
max : integer
weight : integer

FactorCategory

name : string
min : integer
max : integer
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Component

name : string

crc : integer

date : string

listEntries : CStringList

GetMetricValue(metric : Metric) : real
EvaluateComputedMetrics()
GetBasicMetricValue(basicMetric : BasicMetric) : real
GetCriteriaValue(criteria : Criteria) : CriteriaCategory
GetFactorValue(factor : Factor) : FactorCategory
EvaluateFactors()

EvaluateCriterias()

EvaluateQualityModel()

IsExternal() : boolean

GetLanguageName() : LPCTSTR

BasicMetric

name : string

comment : string

scope : integer

index : integer

pfnMetricEngine : LGS_METRIC_ENGINE_PFN = NULL

0.1

*

Metric

name : string

num : integer
comment : string
min : real

max : real

type : integer
mnemonic : string
visualMnemo : string
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ReferenceMetric x| x

Language*

MIEMOoTIC
/scope

AliasMetric

name

BasicMetric

0.1

name

mnemoni

Comment

scope
index
pfnMetricEngine

BasicRule

mnemonic
name
comment
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Component

name : string

crc @ integer

date : string

listEntries : CStringList

GetMetricValue(metric : Metric) : real
EvaluateComputedMetrics()
GetBasicMetricValue(basicMetric : BasicMetric) : real
GetCriteriaValue(criteria : Criteria) : CriteriaCategory
GetFactorValue(factor : Factor) : FactorCategory
EvaluateFactors()

EvaluateCriterias()

EvaluateQualityModel()

IsExternal() : boolean

GetLanguageName() : LPCTSTR

Rule

name : string
key : string

0.1
*
: 0.1 - *
SourceFile |@ RuleViolation
crc : integer
date : string

lineCount : integer

ruleState : string

1

0.1

BasicRule

mnemonic : string
name : string
comment : string
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TestVector

vector : string

Figure 16 Test Vector diagram
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DynamicFile

version : string

'

*

FctComponent

scope : string
type : integer
fctCompSig : string

GetDDPsCount() : integer
GetDDPCovered(i : integer,stat : StatementExec) : boolean

StatementExec

Statement

kind : integer

num : integer

*|. . .
instruction : string

Decision

1 notOperator : boolean
e g g
1 decisionNumber : integer

IsMcdc() : boolean

1 ddps : array<integer>
calls : array<integer>
*
Test
name : string *
comment : string o
mode : boolean
execDate : string
execCmd : string *
execParam : string tested
execStatus : integer
workingDirectory : CPathName
* *
* *
TestVectorTrue
testTrue testTrue
*
TestVectorFalse
testFalse testFals
e

condCount() : integer
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A.3.2 Text Representation

The data model is shown class by class. Classes appear in alphabetical order.

For each class, existing associations, attributes, methods and heirs are listed in the
following format:

class_name class

Associations with:
target_class_name target_role number_instances target class
Attributes:
attribute_name : type
Methods:
method name
Heirs:
class_name

AliasMetric class

Associations with:

Language language n
BasicMetric basicMetricl
Attributes:

mnemonic : string
scope: string
Methods:
LanguagePresent (language : Language) : boolean
GetLanguageCount () : integer
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ApiDomain class

Associations with:

Project project 1

Component componentn
Attributes:

code : string

line : integer

start : integer
length : integer
dirty : boolean

Methods:
MetricValuePresent (component : Component, metric : Metric, pfval : void*):
boolean
GetCriteriaCategory (component : Component, criteria : Criteria) : CriteriaCate-
gory

GetFactorCategory (component : Component, factor : Factor) : FactorCategory
InvalidateContext ()

SetMetricValue (component : Component, metric : Metric, val : real) : boolean
GetComponentCount () : integer

ComponentPresent (component : Component) : boolean
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Application class

Associations with:

start : integer
length : integer
name : string
crc : integer
date : string

Relation to n
Relation from n
ApiDomain apiDomain n
RuleViolation ruleViolation n
BasicMetric basicMetric n
Factor factor n
Criteria criteria n
Metric metric n
MetricValues metricValues 1
CriteriaValues criteriaValues 1
FactorValues factorValues 1
Project project 1
Language language 1
QualityModel qualityModel 1
SourceFile sourceFile 1
Attributes:
code : string
line : integer

listEntries : CstringList

Methods:
GetMetricValue (metric : Metric) : real
EvaluateComputedMetrics ()
GetBasicMetricValue (basicMetric : BasicMetric) : real
GetCriteriaValue (criteria : Criteria) : CriteriaCategory
GetFactorValue (factor : Factor) : FactorCategory
EvaluateFactors ()
EvaluateCriterias ()
EvaluateQualityModel ()
IsExternal () : boolean
GetLanguageName () : LPCTSTR
IsClass () : boolean
IsFctComponent () : boolean
IsApplication () : boolean
IsModule () : boolean
IsFunction () : boolean
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IsMethod () : boolean

MetricPresent (metric : Metric) : boolean
GetMetricCount () : integer

CriteriaPresent (criteria : Criteria) : boolean
GetCriteriaCount () : integer

FactorPresent (factor : Factor) : boolean
GetFactorCount () : integer

BasicMetricPresent (basicMetric : BasicMetric) : boolean
GetBasicMetricCount () : boolean

RuleViolationPresent ( ruleViolation : RuleViolation) : boolean
GetRuleViolationCount () : integer

ApiDomainPresent (apiDomain : ApiDomain) : boolean
GetApiDomainCount () : integer

FromPresent (relation : Relation) : boolean
GetFromCount () : integer

ToPresent (relation : Relation) : boolean

GetToCount () : integer

ApplicationCriteriaclass

Associations with:
Component component n
BaseExpr formula 1
QualityModel qualityModel 1
CriteriaCategorycriteriaCategoryn
Attributes:
name : string
comment : string
num : integer
Methods:
IsClassCriteria () : boolean
IsApplicationCriteria () : boolean
IsModuleCriteria () : boolean
IsFunctionCriteria () : boolean
GetCriteriaCategoryCount () : integer
CriteriaCategoryPresent (criteriaCategory : CriteriaCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
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ApplicationFactor class

Associations with:
Component component
BaseExpr formula
QualityModel qualityModel
FactorCategory  factorCategory

Attributes:
name : string
comment : string
num : integer

Methods:
IsClassFactor () : boolean
IsApplicationFactor () : boolean
IsModuleFactor () : boolean
IsFunctionFactor () : boolean
GetFactorCategoryCount () : integer
FactorCategoryPresent (factorCategory : FactorCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer

S5 = = 3
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ApplicationMetric class

Associations with:
BasicMetric basicMetricl
Component componentn
BaseExpr formula 1
QualityModel qualityModell
Attributes:
name : string
num : integer
comment : string
min : real
max : real
type : integer
mnemonic : string
visualMnemo : string
Methods:
IsClassMetric () : boolean
IsApplicationMetric () : boolean
IsModuleMetric () : boolean
IsFunctionMetric () : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer

BaseExpr class

Associations with:
Attributes:
value : real
Methods:
Evaluate (component : Component) : real
ResolveDependencies (qualityModel : QualityModel)
CheckScope (qualityModel : QualityModel) : integer
IsMetricExpr () : boolean
IsldentifierExpr () : boolean
IsConstExpr () : boolean
IsBinaryExpr () : boolean
IsCriteriaExpr () : boolean
Heirs:
BinaryExpr
ConstExpr
IdentifierExpr
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BasicMetric class

Associations with:

Language language n

Component componentn

AliasMetric aliasMetricn
Attributes:

mnemonic : string
scope : integer
name : string
comment : string
index : integer
Methods:
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
AliasMetricPresent (aliasMetric : AliasMetric) : boolean
GetAliasMetricCount () : integer
LanguagePresent (language : Language) : boolean
GetLanguageCount () : integer

BasicRule class

Associations with:
Language language n
Attributes:
mnemonic : string
name : string
comment : string
Methods:
LanguagePresent (language : Language) : boolean
GetLanguageCount () : integer
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BinaryExpr class

Associations with:
IdentifierExpr depends n
BaseExpr rightExprl
BaseExpr leftExpr 1
Attributes:
value : real
operator : string
Methods:
Evaluate (component : Component) : real
ResolveDependencies (qualityModel : QualityModel)
CheckScope (qualityModel : QualityModel) : integer
IsMetricExpr () : boolean
IsldentifierExpr () : boolean
IsConstExpr () : boolean
IsBinaryExpr () : boolean
IsCriteriaExpr () : boolean

BooleanOperator class

Associations with:

Decision next 1
Decision previous 1
Attributes:

kind : integer

Call class

Associations with:

Component from 1

Component to 1

CallInstance callInstancen
Methods:

IsOther () : boolean

IsFriend () : boolean

IsInheritance () : boolean

IsChild () : boolean

IsCall () : boolean

CalllnstancePresent (calllnstance : Callinstance) : boolean
GetCalllnstanceCount () : integer

Kalimetrix Logiscope
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Calllnstance class

Associations with:
Call call 1
Statement statementl
Attributes:
numCall : integer
line : integer

Child class

Associations with:
pComponent from 1
Component to 1
Methods:
IsOther () : boolean
IsFriend () : boolean
IsInheritance () : boolean
IsChild () : boolean
IsCall () : boolean

Class class

Associations with:

Relation to n
Relation from n
ApiDomain apiDomainn

RuleViolation ruleViolationn

BasicMetric basicMetricn
Factor factor n
Criteria criterian
Metric metric n
MetricValues metricValuesl

CriteriaValues criteriaValuesl

FactorValues factorvValuesl
Project project 1
Language language 1
QualityModel qualityModell
SourceFile sourceFilel
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Class child n

Class parent n
Attributes:

code : string

line : integer

start : integer
length : integer
name : string
crc : integer
date : string
listEntries : CstringList
scope : string
classSig : string
type : integer
Methods:
GetMetricValue (metric : Metric) : real
EvaluateComputedMetrics ()
GetBasicMetricValue (basicMetric : BasicMetric) : real
GetCriteriaValue (criteria : Criteria) : CriteriaCategory
GetFactorValue (factor : Factor) : FactorCategory
EvaluateFactors ()
EvaluateCriterias ()
EvaluateQualityModel ()
IsExternal () : boolean
GetLanguageName () : LPCTSTR
IsClass () : boolean
IsFctComponent () : boolean
IsApplication () : boolean
IsModule () : boolean
IsFunction () : boolean
IsMethod () : boolean
MetricPresent (metric : Metric) : boolean
GetMetricCount () : integer
CriteriaPresent (criteria : Criteria) : boolean
GetCriteriaCount () : integer
FactorPresent (factor : Factor) : boolean
GetFactorCount () : integer
BasicMetricPresent (basicMetric : BasicMetric) : boolean
GetBasicMetricCount () : boolean
RuleViolationPresent ( ruleViolation : RuleViolation) : boolean
GetRuleViolationCount () : integer
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ApiDomainPresent (apiDomain : ApiDomain) : boolean
GetApiDomainCount () : integer

FromPresent (relation : Relation) : boolean
GetFromCount () : integer

ToPresent (relation : Relation) : boolean

GetToCount () : integer

ChildPresent (class : Class) : boolean

GetChildCount () : integer

ParentPresent (class : Class) : boolean
GetParentCount () : integer

ClassCriteriaclass

Associations with:
Component componentn
BaseExpr formula 1
QualityModel qualityModell
CriteriaCategorycriteriaCategoryn

Attributes:
name : string
comment : string
num : integer

Methods:
IsClassCriteria () : boolean
IsApplicationCriteria () : boolean
IsModuleCriteria () : boolean
IsFunctionCriteria () : boolean
GetCriteriaCategoryCount () : integer
CriteriaCategoryPresent (criteriaCategory : CriteriaCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
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ClassFactor class

Associations with:
Component componentn
BaseExpr formula 1
QualityModel qualityModell
FactorCategory factorCategoryn

Attributes:
name : string
comment : string
num : integer

Methods:
IsClassFactor () : boolean
IsApplicationFactor () : boolean
IsModuleFactor () : boolean
IsFunctionFactor () : boolean
GetFactorCategoryCount () : integer
FactorCategoryPresent (factorCategory : FactorCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
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ClassMetric class

Associations with:
BasicMetric basicMetricl
Component componentn
QualityModel qualityModell
BaseExpr formula 1
Attributes:
name : string
num : integer
comment : string
min : real
max : real
type : integer
mnemonic : string
visualMnemo : string
Methods:
IsClassMetric () : boolean
IsApplicationMetric () : boolean
IsModuleMetric () : boolean
IsFunctionMetric () : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
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Component class

Associations with:

Relation to n
Relation from n
ApiDomain apiDomainn
RuleViolation ruleViolationn
BasicMetric basicMetricn
Factor factor n
Criteria criterian
Metric metric n
MetricValues metricValuesl

CriteriaValues criteriaValuesl

FactorValues factorvaluesl

Project project 1

Language language 1

QualityModel qualityModell

SourceFile sourceFilel
Attributes:

code : string

line : integer

start : integer
length : integer
name : string
crc : integer
date : string
listEntries : CstringList
Methods:
GetMetricValue (metric : Metric) : real
EvaluateComputedMetrics ()
GetBasicMetricValue (basicMetric : BasicMetric) : real
GetCriteriaValue (criteria : Criteria) : CriteriaCategory
GetFactorValue (factor : Factor) : FactorCategory
EvaluateFactors ()
EvaluateCriterias ()
EvaluateQualityModel ()
IsExternal () : boolean
GetLanguageName () : LPCTSTR
IsClass () : boolean
IsFctComponent () : boolean
IsApplication () : boolean
IsModule () : boolean
IsFunction () : boolean
IsMethod () : boolean
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MetricPresent (metric : Metric) : boolean
GetMetricCount () : integer
CriteriaPresent (criteria : Criteria) : boolean
GetCriteriaCount () : integer
FactorPresent (factor : Factor) : boolean
GetFactorCount () : integer
BasicMetricPresent (basicMetric : BasicMetric) : boolean
GetBasicMetricCount () : boolean
RuleViolationPresent ( ruleViolation : RuleViolation) : boolean
GetRuleViolationCount () : integer
ApiDomainPresent (apiDomain : ApiDomain) : boolean
GetApiDomainCount () : integer
FromPresent (relation : Relation) : boolean
GetFromCount () : integer
ToPresent (relation : Relation) : boolean
GetToCount () : integer

Heirs:
Class
Application
FctComponent
Module

ConstExpr class

Attributes:
value : real

Methods:
Evaluate (component : Component) : real
ResolveDependencies (qualityModel : QualityModel)
CheckScope (qualityModel : QualityModel) : integer
IsMetricExpr () : boolean
IsldentifierExpr () : boolean
IsConstExpr () : boolean
IsBinaryExpr () : boolean
IsCriteriaExpr () : boolean
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Criteria class

Associations with:
Component component n
BaseExpr formula 1
QualityModel qualityModel 1
CriteriaCategorycriteriaCategoryn
Attributes:
name : string
comment : string
num : integer
Methods:
IsClassCriteria () : boolean
IsApplicationCriteria () : boolean
IsModuleCriteria () : boolean
IsFunctionCriteria () : boolean
GetCriteriaCategoryCount () : integer
CriteriaCategoryPresent (criteriaCategory : CriteriaCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
Heirs:
ClassCriteria
ApplicationCriteria
FunctionCriteria
ModuleCriteria

CriteriaCategory class

Associations with:

Criteria criterial
Attributes:

name : string

min : integer

max : integer

weight : integer
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CriteriaExpr class

Associations with:

BinaryExpr binaryExprl

Criteria criterial
Attributes:

value : real

mnemonic : string
byVal : boolean
Methods:
Evaluate (component : Component) : real
ResolveDependencies (qualityModel : QualityModel)
CheckScope (qualityModel : QualityModel) : integer
IsMetricExpr () : boolean
IsldentifierExpr () : boolean
IsConstExpr () : boolean
IsBinaryExpr () : boolean
IsCriteriaExpr () : boolean

CriteriaValues class

Associations with:

Component componentl
Attributes:

values : array <ClgCriteriaCategory*>
Methods:

AddCriteriaValue (criteriaCategory : CriteriaCategory) : integer
GetCriteriaValue (index : integer) : CriteriaCategory

CtxtObject class

Attributes:
code : string
line : integer
start : integer
length : integer

Heirs :
RuleViolation
Component
Decision
ApiDomain
Statement
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Decision class

Associations with:
BooleanOperator next 1
BooleanOperator previous 1
Decision up 1
Decision down 1
Statement statementl
TestVectorTrue testTrue n
TestVectorFalsetestFalsen

Attributes:
code : string
line : integer
start : integer
length : integer
notOperator : boolean
decisionNumber : integer

Methods:

IsMcdc () : boolean

CondCount () : integer

TestTruePresent ( testVectorTrue : TestVectorTrue) : boolean
GetTestTrueCount () : integer

TestFalsePresent (testVectorFalse : TestVectorFalse) : boolean
GetTestFalseCount () : integer

DynamicFile class

Associations with:

Test test n
Attributes:

fileName : string

pathName : pathName

version : string

Methods:

TestPresent (test : Test) : boolean

GetTestCount () : integer
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Factor class

Associations with:
Component
BaseExpr
QualityModel

componentn
formula 1
qualityModell

FactorCategory factorCategoryn

Attributes:
name : string
comment : string
num : integer
Methods:

IsClassFactor () : boolean

IsApplicationFactor () : boolean

IsModuleFactor () : boolean

IsFunctionFactor () : boolean

GetFactorCategoryCount () : integer

FactorCategoryPresent (factorCategory : FactorCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer

Heirs:
ClassFactor

Applicationfactor

FunctionFactor
ModuleFactor

FactorCategory class

Associations with:
Factor
Attributes:
name : string
min : integer
max : integer
Methods:

factor 1
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FactorValues class

Associations with:

Component componentl
Attributes:

values : array <ClgFactorCategory*>
Methods:

AddFactorValue (factorCategory : FactorCategory) : integer
GetFactorValue (index : integer) : FactorCategory
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FctComponent class

Associations with:

Relation to n
Relation from n
ApiDomain apiDomainn
RuleViolation ruleViolationn
BasicMetric basicMetricn
Factor factor n
Criteria criterian
Metric metric n
MetricValues metricValuesl
CriteriaValues criteriaValuesl
FactorValues factorvValuesl
Project project 1
Language language 1
QualityModel qualityModell
SourceFile sourceFilel
FctComponent called n
FctComponent calling n
Statement statementn
StatementExec statementExecn
Attributes:
code : string
line : integer

start : integer
length : integer
name : string
crc : integer
date : string

listEntries : CstringList

scope : string

type : integer

fctCompsSig : string
Methods:

GetMetricValue (metric : Metric) : real
EvaluateComputedMetrics ()

GetBasicMetricValue (basicMetric : BasicMetric) : real
GetCriteriaValue (criteria : Criteria) : CriteriaCategory

GetFactorValue (factor : Factor) : FactorCategory
EvaluateFactors ()

EvaluateCriterias ()

EvaluateQualityModel ()
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IsExternal () : boolean

GetLanguageName () : LPCTSTR

IsClass () : boolean

IsFctComponent () : boolean

IsApplication () : boolean

IsModule () : boolean

IsFunction () : boolean

IsMethod () : boolean

MetricPresent (metric : Metric) : boolean
GetMetricCount () : integer

CriteriaPresent (criteria : Criteria) : boolean
GetCriteriaCount () : integer

FactorPresent (factor : Factor) : boolean
GetFactorCount () : integer

BasicMetricPresent (basicMetric : BasicMetric) : boolean
GetBasicMetricCount () : boolean

RuleViolationPresent ( ruleViolation : RuleViolation) : boolean
GetRuleViolationCount () : integer

ApiDomainPresent (apiDomain : ApiDomain) : boolean
GetApiDomainCount () : integer

FromPresent (relation : Relation) : boolean
GetFromCount () : integer

ToPresent (relation : Relation) : boolean

GetToCount () : integer

GetDDPsCount () : integer

GetDDPCovered (i : integer, stat : StatementExec) : boolean
FindStatementIndex (statement : Statement) : integer
StatementPresent (statement : Statement) : boolean
GetStatementCount () : integer

CallingPresent (fctComponent : FctComponent) : boolean
GetCallingCount () : integer

CalledPresent (fctComponent : FctComponent) : boolean
GetCalledCount () : integer

StatementExecPresent (statementExec : StatementExec) : boolean
GetStatementExecCount () : integer
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File class

Attributes:
fileName : string
pathName : pathName
Heirs:
StaticFile
SourceFile
DynamicFile
QualityModelFile

Friend class

Associations with:

Component from 1
Component to 1
Methods:

IsOther () : boolean
IsFriend () : boolean
IsInheritance () : boolean
IsChild () : boolean
IsCall () : boolean

Function class

Associations with:

Relation to n
Relation from n
ApiDomain apiDomainn
RuleViolation ruleViolationn
BasicMetric basicMetricn
Factor factor n
Criteria criterian
Metric metric n
MetricValues metricValuesl
CriteriaValues criteriaValuesl
FactorValues factorvValuesl
Project project 1
Language language 1

QualityModel qualityModell
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SourceFile sourceFilel

FctComponent called n

FctComponent calling n

Statement statementn

StatementExec statementExecn
Attributes:

code : string

line : integer

start : integer
length : integer
name : string
crc : integer
date : string
listEntries : CstringList
scope : string
type : integer
fctCompSig : string
Methods:
GetMetricValue (metric : Metric) : real
EvaluateComputedMetrics ()
GetBasicMetricValue (basicMetric : BasicMetric) : real
GetCriteriaValue (criteria : Criteria) : CriteriaCategory
GetFactorValue (factor : Factor) : FactorCategory
EvaluateFactors ()
EvaluateCriterias ()
EvaluateQualityModel ()
IsExternal () : boolean
GetLanguageName () : LPCTSTR
IsClass () : boolean
IsFctComponent () : boolean
IsApplication () : boolean
IsModule () : boolean
IsFunction () : boolean
IsMethod () : boolean
MetricPresent (metric : Metric) : boolean
GetMetricCount () : integer
CriteriaPresent (criteria : Criteria) : boolean
GetCriteriaCount () : integer
FactorPresent (factor : Factor) : boolean
GetFactorCount () : integer
BasicMetricPresent (basicMetric : BasicMetric) : boolean
GetBasicMetricCount () : boolean
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RuleViolationPresent ( ruleViolation : RuleViolation) : boolean
GetRuleViolationCount () : integer

ApiDomainPresent (apiDomain : ApiDomain) : boolean
GetApiDomainCount () : integer

FromPresent (relation : Relation) : boolean

GetFromCount () : integer

ToPresent (relation : Relation) : boolean

GetToCount () : integer

GetDDPsCount () : integer

GetDDPCovered (i : integer, stat : StatementExec) : boolean
FindStatementIndex (statement : Statement) : integer
StatementPresent (statement : Statement) : boolean
GetStatementCount () : integer

CallingPresent (fctComponent : FctComponent) : boolean
GetCallingCount () : integer

CalledPresent (fctComponent : FctComponent) : boolean
GetCalledCount () : integer

StatementExecPresent (statementExec : StatementExec) : boolean
GetStatementExecCount () : integer

FunctionCriteria class

Associations with:
Component component n
BaseExpr formula 1
QualityModel qualityModel 1
CriteriaCategorycriteriaCategoryn
Attributes:
name : string
comment : string
num : integer
Methods:
IsClassCriteria () : boolean
IsApplicationCriteria () : boolean
IsModuleCriteria () : boolean
IsFunctionCriteria () : boolean
GetCriteriaCategoryCount () : integer
CriteriaCategoryPresent (criteriaCategory : CriteriaCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
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FunctionFactor class

Associations with:
Component componentn
BaseExpr formula 1
QualityModel qualityModell
FactorCategory factorCategoryn

Attributes:
name : string
comment : string
num : integer
Methods:
IsClassFactor () : boolean
IsApplicationFactor () : boolean
IsModuleFactor () : boolean
IsFunctionFactor () : boolean
GetFactorCategoryCount () : integer
FactorCategoryPresent (factorCategory : FactorCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer

FunctionMetric class

Associations with:

BasicMetric basicMetricl

Component componentn

QualityModel qualityModell

BaseExpr formula 1
Attributes:

name : string

num : integer

comment : string  min : real

max : real

type : integer
mnemonic : string
visualMnemo : string
Methods:
IsClassMetric () : boolean
IsApplicationMetric () : boolean
IsModuleMetric () : boolean
IsFunctionMetric () : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
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IdentifierExpr class

Associations with:
BinaryExpr binaryExprl
Attributes:
value : real
mnemonic : string
byVal : boolean
Methods:
Evaluate (component : Component) : real
ResolveDependencies (qualityModel : QualityModel)
CheckScope (qualityModel : QualityModel) : integer
IsMetricExpr () : boolean
IsldentifierExpr () : boolean
IsConstExpr () : boolean
IsBinaryExpr () : boolean
IsCriteriaExpr () : boolean
Heirs:
MetricExpr
CriteriaExpr

Inheritance class

Associations with:

Component from
Component to
Methods:

IsOther () : boolean
IsFriend () : boolean
IsInheritance () : boolean
IsChild () : boolean
IsCall () : boolean

Language class

Attributes:
name : string
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LCSAJ class
Associations with:
Statement Jump
StmtCtrl end
StmtCtrl start
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Method class

Associations with:
Relation
Relation
ApiDomain
RuleViolation
BasicMetric
Factor
Criteria
Metric
MetricValues
CriteriaValues
FactorValues
Project
Language
QualityModel
SourceFile
FctComponent
FctComponent
Statement
StatementExec

Attributes:
code : string
line : integer
start : integer
length : integer
name : string
crc : integer
date : string

to n
from n
apiDomainn
ruleViolationn
basicMetricn
factor n
criterian
metric n
metricValuesl
criteriaValuesl
factorvValuesl
project 1
language 1
qualityModell
sourceFilel
called n
calling n
statementn
statementExecn

listEntries : CstringList

scope : string
type : integer

fctCompsSig : string

access : integer
Methods:

GetMetricValue (metric : Metric) : real
EvaluateComputedMetrics ()

GetBasicMetricValue (basicMetric : BasicMetric) : real
GetCriteriaValue (criteria : Criteria) : CriteriaCategory
GetFactorValue (factor : Factor) : FactorCategory

EvaluateFactors ()

EvaluateCriterias ()

A-50 Kalimetrix Logiscope Studio Reference Manual



Kalimetrix Logiscope

EvaluateQualityModel ()

IsExternal () : boolean

GetLanguageName () : LPCTSTR

IsClass () : boolean

IsFctComponent () : boolean

IsApplication () : boolean

IsModule () : boolean

IsFunction () : boolean

IsMethod () : boolean

MetricPresent (metric : Metric) : boolean
GetMetricCount () : integer

CriteriaPresent (criteria : Criteria) : boolean
GetCriteriaCount () : integer

FactorPresent (factor : Factor) : boolean
GetFactorCount () : integer

BasicMetricPresent (basicMetric : BasicMetric) : boolean
GetBasicMetricCount () : boolean

RuleViolationPresent ( ruleViolation : RuleViolation) : boolean
GetRuleViolationCount () : integer

ApiDomainPresent (apiDomain : ApiDomain) : boolean
GetApiDomainCount () : integer

FromPresent (relation : Relation) : boolean
GetFromCount () : integer

ToPresent (relation : Relation) : boolean

GetToCount () : integer

GetDDPsCount () : integer

GetDDPCovered (i : integer, stat : StatementExec) : boolean
FindStatementIndex (statement : Statement) : integer
StatementPresent (statement : Statement) : boolean
GetStatementCount () : integer

CallingPresent (fctComponent : FctComponent) : boolean
GetCallingCount () : integer

CalledPresent (fctComponent : FctComponent) : boolean
GetCalledCount () : integer

StatementExecPresent (statementExec : StatementExec) : boolean
GetStatementExecCount () : integer

Data Model A-51



Kalimetrix Logiscope

Metric class

Associations with:
BasicMetric
Component
QualityModel
BaseExpr

Attributes:
name : string
num : integer
comment : string
min : real
max : real
type : integer

mnemonic : string
visualMnemo : string

Methods:

basicMetricl
componentn
qualityModell
formula 1

IsClassMetric () : boolean

IsApplicationMetric () : boolean

IsModuleMetric () : boolean

IsFunctionMetric () : boolean

ComponentPresent (component : Component) : boolean
GetComponentCount () : integer

Heirs:
ClassMetric

ApplicationMetric

FunctionMetric
ModuleMetric
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MetricExpr class

Associations with:

BinaryExpr binaryExprl

Metric metric 1
Attributes:

value : real

mnemonic : string
byVal : boolean
Methods:
Evaluate (component : Component) : real
ResolveDependencies (qualityModel : QualityModel)
CheckScope (qualityModel : QualityModel) : integer
IsMetricExpr () : boolean
IsldentifierExpr () : boolean
IsConstExpr () : boolean
IsBinaryExpr () : boolean
IsCriteriaExpr () : boolean

MetricValues class

Associations with:
Component
Attributes:
values : array <real>

componentl
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Module class

Associations with:

start : integer
length : integer
name : string
crc : integer
date : string

Relation to n
Relation from n
ApiDomain apiDomain n
RuleViolation ruleViolation n
BasicMetric basicMetric n
Factor factor n
Criteria criteria n
Metric metric n
MetricValues metricValues 1
CriteriaValues criteriaValues 1
FactorValues factorValues 1
Project project 1
Language language 1
QualityModel qualityModel 1
SourceFile sourceFile 1
Attributes:
code : string
line : integer

listEntries : CstringList

Methods:
GetMetricValue (metric : Metric) : real
EvaluateComputedMetrics ()
GetBasicMetricValue (basicMetric : BasicMetric) : real
GetCriteriaValue (criteria : Criteria) : CriteriaCategory
GetFactorValue (factor : Factor) : FactorCategory
EvaluateFactors ()
EvaluateCriterias ()
EvaluateQualityModel ()
IsExternal () : boolean
GetLanguageName () : LPCTSTR
IsClass () : boolean
IsFctComponent () : boolean
IsApplication () : boolean
IsModule () : boolean
IsFunction () : boolean
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IsMethod () : boolean

MetricPresent (metric : Metric) : boolean
GetMetricCount () : integer

CriteriaPresent (criteria : Criteria) : boolean
GetCriteriaCount () : integer

FactorPresent (factor : Factor) : boolean
GetFactorCount () : integer

BasicMetricPresent (basicMetric : BasicMetric) : boolean
GetBasicMetricCount () : boolean

RuleViolationPresent ( ruleViolation : RuleViolation) : boolean
GetRuleViolationCount () : integer

ApiDomainPresent (apiDomain : ApiDomain) : boolean
GetApiDomainCount () : integer

FromPresent (relation : Relation) : boolean
GetFromCount () : integer

ToPresent (relation : Relation) : boolean

GetToCount () : integer

ModuleCriteria class

Associations with:
Component component n
BaseExpr formula 1
QualityModel qualityModel 1
CriteriaCategorycriteriaCategoryn
Attributes:
name : string
comment : string
num : integer
Methods:
IsClassCriteria () : boolean
IsApplicationCriteria () : boolean
IsModuleCriteria () : boolean
IsFunctionCriteria () : boolean
GetCriteriaCategoryCount () : integer
CriteriaCategoryPresent (criteriaCategory : CriteriaCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer

Data Model A-55



Kalimetrix Logiscope

ModuleFactor class

Associations with:
Component component
BaseExpr formula
QualityModel qualityModel
FactorCategory  factorCategory

Attributes:
name : string
comment : string
num : integer

Methods:
IsClassFactor () : boolean
IsApplicationFactor () : boolean
IsModuleFactor () : boolean
IsFunctionFactor () : boolean
GetFactorCategoryCount () : integer
FactorCategoryPresent (factorCategory : FactorCategory) : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer

S5 = = 3
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ModuleMetric class

Associations with:
BasicMetric basicMetricl
Component componentn
BaseExpr formula 1
QualityModel qualityModell
Attributes:
name : string
num : integer
comment : string
min : real
max : real
type : integer
mnemonic : string
visualMnemo : string
Methods:
IsClassMetric () : boolean
IsApplicationMetric () : boolean
IsModuleMetric () : boolean
IsFunctionMetric () : boolean
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer

Other class

Associations with:

Component from 1
Component to
Attributes:
name : string
Methods:

IsOther () : boolean
IsFriend () : boolean
IsInheritance () : boolean
IsChild () : boolean
IsCall () : boolean
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Project class

Associations with:

Rule rule n
Component component n
DynamicFile dynamicFile n
StaticFile staticFile n
SourceFile sourceFile n
ApiDomain crtDomain 1
QualityModelFilequalityModelFile 1l
Attributes:

fileName : string
pathName : pathname
creationDate : string
dataDirectory : CPathName
buildCmd : string
buildArgs : string
testDirectory : CpathName
binaryArgs : string
binary : string
binaryType : boolean
sourceDirectory : CPathName
Methods:
Load () : integer
Save () : integer
FindSourceFile (pathName : string) : SourceFile
EvaluateQualityModel ()
GetQualityModel () : QualityModel
FindStaticFile (pathName : string) : StaticFile
DynamicFilePresent (dynamicFile : DynamicFile) : boolean
GetDynamicFileCount () : integer
SourceFilePresent (sourceFile : SourceFile) : boolean
GetSourceFileCount () : integer
StaticFilePresent (staticFile : StaticFile) : boolean
GetStaticFileCount () : integer
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
RulePresent (rule : Rule) : boolean
GetRuleCount () : integer
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QualityModel class

Associations with:
FunctionCriteriafunctionCriterian
ClassCriteria <classCriterian
ApplicationCriteriaapplicationCriterian
ModuleCriteria moduleCriterian
FunctionFactor functionFactorn

ClassFactor classFactorn
ApplicationFactorapplicationFactorn
ModuleFactor moduleFactorn
FunctionMetric functionMetricn
ClassMetric classMetricn
ApplicationMetricapplicationMetricn
ModuleMetric moduleMetricn
QualityModelFilequalityModelFilel
Factor factor n
Criteria criteria n
Metric metric n
Language language n
Methods:

FindMetricIndex (metric : Metric) : integer
GetMetricCount () : integer

MetricPresent (metric : Metric) : boolean
GetCriteriaCount () : integer

CriteriaPresent (criteria : Criteria) : boolean
GetFactorCount () : integer

FactorPresent (factor : Factor) : boolean
GetLanguageCount () : integer

LanguagePresent (language : Language) : boolean

QualityModelFile class

Associations with:
QualityModel qualityModeln
Attributes:
fileName : string
pathName : pathName
version : string
Methods:
FindQualityModel (language : Language) : QualityModel
QualityModelPresent (qualityModel : QualityModel) : boolean
Get QualityModelCount () : integer
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ReferenceMetric class

Associations with:

Language language n
Attributes :

mnemonic : string

scope : string
Methods :

LanguagePresent (language : Language) : boolean

GetLanguageCount () : integer
Heirs :

BasicMetric

AliasMetric

Relation class

Associations with:

Component from 1
Component to 1
Methods:

IsOther () : boolean

IsFriend () : boolean

IsInheritance () : boolean

IsChild () : boolean

IsCall () : booleanAssociations with:
Heirs:

Friend

Other

Inheritance

Child

Call
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Rule class

Associations with:
RuleViolation ruleViolationn
BasicRule basicRulel
Attributes:
name : string
key : string
ruleState : string
Methods:
RuleViolationPresent (ruleViolation : RuleViolation) : boolean
Get RuleViolationCount () : integer

RuleViolation class

Associations with:

Component componentl

Rule rule 1

SourceFile sourceFilel
Attributes:

code : string

line : integer

start : integer
length : integer
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SourceFile class

Associations with:

SourceFile included n

SourceFile includes n

Component component n

RuleViolation ruleViolationn

Language language 1
Attributes:

fileName : string
pathName : pathName
crc : integer
date : string
lineCount : integer

Methods:
IncludedPresent (sourceFile : SourceFile) : boolean
GetIncludedCount () : integer
IncludesPresent (sourceFile : SourceFile) : boolean
GetIncludesCount () : integer
RuleViolationPresent (ruleViolation : RuleViolation) : boolean
GetRuleViolationCount () : integer
ComponentPresent (component : Component) : boolean
GetComponentCount () : integer
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Statement class

Associations with:
CallInstance callInstancen
FctComponent fctComponentl
Decision decision n
StmtJump stmtJump n
Branch srcBranchn
Test tested n
Attributes:
code : string
line : integer
length : integer
kind : integer
num : integer
instruction : string
Methods:
DecisionPresent (decision : Decision) : boolean
GetDecisionCount () : integer
SrcBranchPresent (branch : Branch) : boolean
GetSrcBranchCount () : integer
StmtJumpPresent (stmtJump : StmtJump) : boolean
GetStmtJumpCount () : integer
TestedPresent (test : Test) : boolean
GetTestedCount () : integer
CallinstancePresent (calllnstance : Calllnstance) : boolean
GetCalllnstanceCount () : integer
IsStmtCtrl () : boolean
IsStmtSequence () : boolean
IsStmtJump () : boolean
Heirs:
StmtCtrl
StmtSequence
StmtJump

StatementExec class

Associations with:

FctComponent fctComponent 1
Test test
Attributes:

ddps : array <integer>calls : array <integer>
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StaticFile class

Associations with:
SourceFile sourceFile n
Attributes:
fileName : string
pathName : pathName
Methods:
SourceFilePresent (sourceFile : SourceFile) : boolean
GetSourceFileCount () : integer

StmtCtrl class

Associations with:

CallInstance callInstance n
FctComponent fctComponent 1
Decision decision n
StmtJump stmtJump n
Branch srcBranch n
Test tested n
Branch destinationBranch n
LCSAJ 1CSAJ n
Attributes:
code : string
line : integer

start : integer
length : integer
kind : integer
num : integer
instruction : string
Methods:
DecisionPresent (decision : Decision) : boolean
GetDecisionCount () : integer
SrcBranchPresent (branch : Branch) : boolean
GetSrcBranchCount () : integer
StmtJumpPresent (stmtJump : StmtJump) : boolean
GetStmtJumpCount () : integer
TestedPresent (test : Test) : boolean
GetTestedCount () : integer
CalllnstancePresent (calllnstance : Calllnstance) : boolean
GetCalllnstanceCount () : integer
IsStmtCtrl () : boolean
IsStmtSequence () : boolean
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IsStmtJump () : boolean

LCSAJPresent (ICSAJ : LCSAJ) : boolean
GetLCSAJCount () : integer
DestinationBranchPresent (branch : Branch) : boolean
GetDestinationBranchCount () : integer

StmtJump class

Associations with:

CallInstance callInstance n
FctComponent fctComponent 1
Decision decision n
StmtJump stmtJump n
Branch srcBranch n
Test tested n
Statement destination 1
Attributes:
code : string
line : integer

start : integer
length : integer
kind : integer
num : integer
instruction : string
label : string
instrJump : integer

Methods:
DecisionPresent (decision : Decision) : boolean
GetDecisionCount () : integer
SrcBranchPresent (branch : Branch) : boolean
GetSrcBranchCount () : integer
StmtJumpPresent (stmtJump : StmtJump) : boolean
GetStmtJumpCount () : integer
TestedPresent (test : Test) : boolean
GetTestedCount () : integer
CalllnstancePresent (calllnstance : Callinstance) : boolean
GetCalllnstanceCount () : integer
IsStmtCtrl () : boolean
IsStmtSequence () : boolean
IsStmtJump () : boolean
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StmtSequence class

Associations with:

CallInstance callInstance n
FctComponent fctComponent 1
Decision decision n
StmtJump stmtJump n
Branch srcBranch n
Test tested n
Attributes:
code : string
line : integer

start : integer
length : integer
kind : integer
num : integer
instruction : string
stmtCount : integer
Methods:
DecisionPresent (decision : Decision) : boolean
GetDecisionCount () : integer
SrcBranchPresent (branch : Branch) : boolean
GetSrcBranchCount () : integer
StmtJumpPresent (stmtJump : StmtJump) : boolean
GetStmtJumpCount () : integer
TestedPresent (test : Test) : boolean
GetTestedCount () : integer
CalllnstancePresent (calllnstance : Calllnstance) : boolean
GetCalllnstanceCount () : integer
IsStmtCtrl () : boolean
IsStmtSequence () : boolean
IsStmtJump () : boolean

Test class

Associations with:

TestVectorTrue testTrue n
TestVectorFalse testFalse n
DynamicFile dynamicFile 1
StatementExec statementExec n

A-66 Kalimetrix Logiscope Studio Reference Manual



Kalimetrix Logiscope

Attributes:
name : string
comment : string
mode : boolean
execDate : string
execCmd : string
execParam : string
execStatus : integer
workingDirectory : CPathName
Methods:
TestTruePresent (testVectorTrue : TestVectorTrue) : boolean
GetTestTrueCount () : integer
TestFalsePresent (testVectorFalse : TestVectorFalse) : boolean
GetTestFalseCount () : integer
StatementExecPresent (statementExec: StatementExec) : boolean
GetStatementExecCount () : integer

TestVector class

Attributes:

vector : string
Methods:
IsTestVectorTrue () : boolean
IsTestVectorFalse () : boolean
Heirs:
TestVectorTrue
TestVectorFalse

TestVectorFalse class

Associations with:
Decision decision 1
Attributes:
vector : string
Methods:
IsTestVectorTrue () : boolean
IsTestVectorFalse () : boolean
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TestVectorTrue class

Associations with:
Decision decision 1
Attributes:
vector : string
Methods:
IsTestVectorTrue () : boolean
IsTestVectorFalse () : boolean
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A.4 Access commands

Access to the class attribute

Classobject

Returns the name of the class of object. An error is reported if object is not a valid key.

Access to other attributes

Get object attribute

Returns the value of attributes of object designated by attribute. An error is reported if
attribute does not designate an attribute of object or if object is not a valid key.

Access to a single cardinality role
GetRole source_object target_role

Applies to associations whose target class has cardinality O or 1( ).

Returns the key of the object which has the target_role in one of the associations of
source_object, or an empty string if there are no such associations. An error is reported if
source_object has no association with target_role as a role.

Access to a multiple cardinality role

MapRole source_object target_role -filter fscript script

fscript and script represent a sequence of commands.

Applies to associations whose cardinality is greater than or equal to 0( ).
It scans objects associated with the source_object which have target_role as a role.

For each object which is the target_role in one of the associations of source_object, the
fscript command sequence is evaluated:

« if fscript returns a value greater than 0, the script sequence is evaluated,

« if fscript returns a value equal to 0, the script sequence is not evaluated.

If fscript is not present, script is always evaluated.

If script returns a value equal to 0, the MapRole command stops immediately.

At each evaluation, fscript and script receive as a parameter the identifier of the object to
process.

The MapRole command returns the number of times script has been evaluated. This
number represents the overall number of objects which have target_role as a role in one
of the associations of source_object or, if a filter is specified, it represents the number of

Data Model A-69



Kalimetrix Logiscope

objects that match the filtering condition. An error is reported:
« if source_object has no association with, as a role, a target object: target_role,
« if fscript and script end with an uncontrolled value.
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A.5 Debugging aid commands

Roles of a class
* Roles Of object

Returns the role list for the class of which object is an instance.

Attributes of a class
+ Attributes Of object

Returns the attribute list for the class of which object is an instance.
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Appendix B

Using Logiscope on UNIX

B.1

This appendix presents some UNIX specific behaviors and utilities.

Printer Settings

You can easily add a new printer or change your default printer through the mwprinter
utility, which launches a printer applet similar to the Windows printers one.

The Printers applet includes a default generic postscript printer command mapping that
satisfies most printing needs. The PRINTER environment variable should be set to your
default printer name.

If you need to add other printer command mappings, you can use the Add Printer
wizard described below.

Changes you make using the Printers applet have an impact on the applications running
on the same machine ; they become effective after saving. Applications running on other
machines must be restarted for the changes to be effective.

To add a printer using the Add Printer wizard:

1. Launch the Visual MainWin Control Panel.

2. Double-click Printers. The MainWin Printers applet opens.

B3I MainWin Printers Hi=] E3
Fle View Help

Add Newr Genenc

kainWin Printer Postscript

Printers
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3. Double-click Add New Printer in the MainWin Printers applet. The Add
Printer Wizard starts.

Welcome to the Add Printer Wizard
This wizard helps you make printer connections.

To continue, click Next.

< Back MNext » Cancel
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4. Click Next.

Identify your Unix Printer

Please identify your Unix printer.

The following printers have been found on this Unix host.

Most users simply need to select the desired printer from the
list.

If your system administrator instructs you to use a printer
that is not in the list, type the Unix name of the printer in the

combo box
Unix printer:

Name: | Description: |

ligm HP Laserjet printer at first floor =

ljis-0 HP Laserjet printer at entrance floor

ps2 Mita prinet and xerox machine

na HP kAP | acsariat mrintar Af tha servitars ;I
< Back Next > Cancel |

5. Specify the UNIX printer you want to use.

A list of printers defined on the UNIX host appears at the bottom of the wizard. If the
printer you want to add is included in the list, select it. To add a printer that is not in the
list, enter the UNIX name of the printer in the UNIX printer text field.

Note: The list of printers is extracted from the /etc/printcap file, which contains the list of
all printers on the network to which your UNIX host has access. The printcap file is used

on all UNIX platforms as the central location for specifying printers. It is configured and
maintained by the system administrator.
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6. Click Next.

Print Command

Please confirm the print command.

This command is the Unix command used to print. The
default command will work for most users. Do not change
the default command unless instructed to do so by your
system administrator.

MNote: Use %s to specify the temporary print file name in the
print command.

To confirm the print command, please click Next.

Print Command:

< Back MNext » Cancel

The default print command for the selected printer appears in the Print Command
text field. Usually, the default command is the one you should use. You should not
modify the command unless your system administrator instructs you to do so.
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Printer Hame

Please specify a name for this printer. This name is used to
identify the printer in your application .

Printer Name;

HP Laserjet printer at first floor

You may optionally specify a description for this printer. This
description helps you to identify the printer

< Back Mext » Cancel

The Printer Name is used by the application when displaying available printers in the
Print dialog. You may modify the default name if you wish.

The printer description has the same functionality as on Microsoft Windows. This field

may be left blank.
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8. Click Next.

Finish Adding Hew Printer

:

;'binfsﬁ —c"cat %s ||

Printer Name:
HP Laserjet

Printer Description:

printer at first floor

.

< Back Finish Cancel |

9. Make sure the information you specified in the Add Printer wizard is correct.
If you are satisfied with the settings, click Finish. Otherwise, click Back to change
settings.

The printer you added now appears in the printers list.

B3 MainWin Printers M=l E3
File View Help

oy - EmE | P

&

Add Mew Generic  HP Laserjet

MainWin I Postscript  printer at...
Printers
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B.2 Docking bar

The floating bar behaves differently in Windows NT and in MainWin.

Behavior on Windows NT Behavior on MainWin

If you double-click the title bar of a float- | Double-clicking the title bar of a floating
ing toolbar window, the toolbar returnsto | toolbar window has no effect. For the tool-
its original position on the application bar to return to its location on the applica-
window, below the menu bar. tion window, click the system menu in the
top left corner of the toolbar window and
select Redock.

When dragging a floating toolbar win- When dragging a floating toolbar window
dow over the toolbar area of the applica- | over the toolbar area of the application win-
tion window, a rectangle appears to dow, no rectangle appears to indicate the
indicate the size and location of the tool- | size and location of the toolbar on the appli-
bar that should be dropped to that posi- cation window. Instead, the floating toolbar
tion. is dragged. When dropped, the toolbar is

correctly set in the application window.

B.3 Help

The online help can be accessed outside Studio through the following command:

<logiscope install>/bin/hh <logiscope install>/bin/lgvcs.chm
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Appendix C

Notices

© Copyright 2014

The licensed program described in this document and all licensed material
available for it are provided by Kalimetrix under terms of the Kalimetrix
Customer Agreement, Kalimetrix International Program License Agreement
or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-
level systems and there is no guarantee that these measurements will be the same
on generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-Kalimetrix products was obtained from the suppliers
of those products, their published announcements or other publicly available
sources. Kalimetrix has not tested those products and cannot confirm the accuracy
of performance, compatibility or any other claims related to non-Kalimetrix
products. Questions on the capabilities of non-Kalimetrix products should be
addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Copyright license

This information contains sample application programs in source language,
which illustrate programming techniques on various operating platforms. You
may copy, modify, and distribute these sample programs in any form without
payment to Kalimetrix, for the purposes of developing, using, marketing or
distributing application programs conforming to the application programming
interface for the operating platform for which the sample programs are
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written. These examples have not been thoroughly tested under all conditions.
Kalimetrix, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from Kalimetrix
Corp. Sample Programs. © Copyright Kalimetrix Corp. _enter the year or years_.

Trademarks

Kalimetrix, the Kalimetrix logo, Kalimetrix.com are trademarks or registered
trademarks of Kalimetrix, registered in many jurisdictions worldwide. Other
product and services names might be trademarks of Kalimetrix or other
companies.

Adobe, the Adobe logo, Acrobat, the Acrobat logo, FrameMaker, and PostScript
are trademarks of Adobe Systems Incorporated or its subsidiaries and may be
registered in certain jurisdictions.

AlX and Informix are trademarks or registered trademarks of International
Business Machines Corporation in the United States, other countries, or both.

HP and HP-UX are registered trademarks of Hewlett-Packard Corporation.

Java and all Java-based trademarks and logos are trademarks of Sun
Microsystems, Inc. in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft, Windows, Windows 2003, Windows XP, Windows Vista and/or other
Microsoft products referenced herein are either trademarks or registered
trademarks of Microsoft Corporation.

Netscape and Netscape Enterprise Server are registered trademarks of Netscape
Communications Corporation in the United States and other countries.

Sun, Sun Microsystems, Solaris, and Java are trademarks or registered trademarks
of Sun Microsystems, Inc. in the United States and other countries.

Pentium is a trademark of Intel Corporation.

ITIL is aregistered trademark, and a registered community trademark of the
Office of Government Commerce, and is registered in the U.S Patent and
Trademark Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product or service names may be trademarks or service marks of
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Hide, 2-6, 3-68
Home, 3-69

Inheritance, A-4
Insert project into workspace, 3-70

L

Large Icons, 3-72
Logiscope API, A-1
Logiscope TestChecker, 2-6
Logiscope Viewer, 2-6
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Menu

Browse, 2-5

Edit, 2-5

File, 2-5

Help, 2-5

Project, 2-5

Tools, 2-5

View, 2-5

Window, 2-5
Menu Bar, 2-5
Metric Values tab, 2-18
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New Application Criteria, 3-83
New Application Factor, 3-84
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New Class Factor, 3-87
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New Function Factor, 3-90
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Next Item, 3-94

O

Open file, 3-95

Open Workspace, 3-97
Operation, A-2

Output, 3-109

Output window, 1-1, 2-4

P

Paste, 3-110
Previous Item, 3-111
Print, 3-112
Print Preview, 3-114
Print Setup, 3-115
Project

Settings, 3-142
Project Bar, 2-6
Properties, 3-117

Q

Quality Model, 2-7
QualityEdit tab, 2-14

R

Recent Files, 3-125, 3-126
Redo, 3-127
Refresh, 3-128
Replace, 3-129
Representation

graphical, A-5

text, A-22
Result pane, 1-1, 2-4
Role, A-3
Rule Violation List, 2-7
Rule Violation Report, 2-7
Rule Violations, 2-7

S

Save All, 3-136
Save As, 3-137
Save file, 3-135
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Save workspace, 3-138 W
Script Wizard, 2-26, 3-139 Workspace, 3-176
Select All, 3-140 Workspace View, 1-1, 2-4

Select From Properties, 3-141
Set as Active Project, 2-6
Settings
Project, 3-142
Shortcuts, 3-143
Small Icons, 3-144
Start TestChecker, 2-7, 3-161
Start the Quality Model Editor, 4-197
Start Viewer, 2-6, 3-162
Status Bar, 2-5
Stop, 2-6, 3-163
Studio
purpose, 1-1
Studio views (presentation), 1-1

T

Tcl
=Tool Command Language, 2-9

Tcl Script Bar, 2-9
Test Report, 2-7
Textual view, 2-28
Tile, 2-10, 3-171, 3-172
Tile Horizontally, 2-11
Tile Vertically, 2-10
To Shortcut Bar, 3-173
Toolbar, 3-158
Toolbars

shortcuts, 2-7
Tools

Customize, 2-6

U

UML Browser Bar, 2-9
Undo, 3-174

Unix, 2-3

User Request tab, 2-19

V

vCs binary, 2-3
Violations tab, 2-20
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